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LEN T 545
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LR S VAU o 547

R S (VAU . 547
LD DD 548
LK P 551
L OO 553
M 555
MO D IV = O MULE . 557
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R MU L 560
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D B 564
D 566
D E 568
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ME A (IS TANCE M S]] oo 580
M CT P arg L arg ) ol 583
ME D (ISt ANC Y S]] oo 585
ME DIV =  Or MU 588
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ME LT P= OrmUL 596
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MO 610
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P 613
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IO R 618
T 620
T B 622
I 624
N T 626

N 626
O=formula, O(trj¥)=formula .. ... . 628
O ) e 630

RO C ) 630
O CHN ) 632
O ) oo 634

RO () oo 634
O 636
OR(VAlUE) 638
O () e 640
OSH=formula, OSH(trj#)=formula ... .. . 642
OUT (= OrmULE 644
P A 646

R A 646
P AU S 648
PG, P aXIS) .o 650

RPC, RPC(AXIS) ...t 650
Pl 653

Rl 653
P D 654
P A 657

R I A 657
P =formuUla 659

R I 659
P =formula . 661

R T 661
PR A 663

R R A 663
PR 666

R R 666
P RINT () 669
PRINT O( ) o 673
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P RIN T () 677

P RINT B ..) 680
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R R 683
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PRI S S () e 688
P =formuUla o 690

R T 690
P S ) oo 692
P O D 695

R T S D o 695
P T S S () oo 696
P ST 698

R T ST 698
RANDOM=FOIrMULA ... 699

RRAND OM 699
RO S 701
RE S 702

RRE S 702
RESUME 704
RETURN 706
RETURNI e 708
RO P 710
RO P L 712
RO P S 713
RUN 714
RUN 2 716
S (@5 COMMAN) 718
S A D D R 720
A P 722

RS A P 722
SO AL B A (M) 724
SCALE P ML) o 726
SO ALV (M ) 728
SDORD ) e 730

RO D O R D . 730
D O R ) o 732
S EN T 734
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S EN T L 736

SIN(VAIUE) 738
RGIN(VAIUE) o 738
LD 740
L E 742
LB P 744
S BB P L 746
LM MO 748
RO LT 748
SN = O MUl L 750
RO LN 750
S P = O MU . 752
RO L P 752
SN AME (SN ) . 754
P 755
RO P 755
P G 756
RO PO 756
SR T (VAU e 757
R QR T (VAU e 757
SR ONC ST C) e 759
ST A K 761
STDOUT=TOMMULE . 764
SWIT CH formULE . 766
o oMUl L 769
R 769
T LK 771
TA LK L 773
TAN(VAIUE) 775
R AN(VAIUE) 775
TEMP, TEM P arg) o 777
RTEMP, RTEM P @) . 777
TH= oMUl 779
R H 779
T R e im0 e 782
R M I R IO e 782
TR 784
R RO 784
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RS 786
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T AT (BN e 789
U A 791

RU A 791
U A 793

RU A 793
UO () o0mmUla o 795
P 797
UP L O A DD e 799
UR () e 801
U S ) e 803
U Blarg) oo 805

RUS B 805
VA 807

R A 807
VA C @) oo 810
VL 815

RV G 815
VL= oMUl L 818

R L 818
VLD (Variab e, UMD O ) . 820
VST (variable, MU ) 824
VT = OrmMULE 828

R T 828
VT = O MU . 831
O ) e 833

R (WO ) e 833
WAL =formula .. 835
A E 837
A E L 839
WHILE formula ..o 841
U UPE PR 844
L 846
WO DIt 848
i 850
L 851
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Introduction: Overview

Overview

The SmartMotor™ Developer's Guide is designed to be used by system developers and programmers
when developing applications for the SmartMotor. Before using the SmartMotor™ Developer's Guide, it
is strongly recommended that you first read the SmartMotor™ Installation & Startup Guide for your
SmartMotor, which describes how to install and start up the SmartMotor, and test initial
communications with the motor. After that, use this guide to learn about advanced SmartMotor
features, how to develop SmartMotor applications, and the details of each command.

Part One of this guide provides information on basic to advanced programming, along with related
information on key SMI software features, communications, motion control, program flow control, error
and fault handling, and more.

Part Two of this guide lists all the SmartMotor commands in alphabetical order. Each command is
described in detail. Code snippets and examples are provided where applicable. These are shown in a
Courier font. Comments are included and separated with a single quotation mark as they would be in
your own programs.

NOTE: The programs and code samples in this manual are provided for example purposes only. It is
the user's responsibility to decide if a particular code sample or program applies to the application
being developed and to adjust the values to fit that application.

Also, where appropriate, a Related Commands section is included, which is located at the end of the
command page. It is designed to guide you to other commands that offer similar functionality, and
ensure you are aware of every programming option the SmartMotor provides to address your specific
application requirements.

Part Three of this guide provides a library of useful example SmartMotor programs. These can be used
as "how to" examples for using a particular SmartMotor feature or solving a particular application
problem, or as starting points for your application.

NOTE: The programs and code samples in this manual are provided for example purposes only. It is
the user's responsibility to decide if a particular code sample or program applies to the application
being developed and to adjust the values to fit that application.

The Appendix of this guide contains additional topics such as an array map, ASCII character set,
command error codes, and other information that is useful to have handy during application
development.

A quick-reference command list is also included at the end of this guide.

Combitronic Support

NOTE: For the Class 5 D- and M-style SmartMotors, Combitronic communication is available on
models with the -CAN option. For the Class 6 D-style SmartMotor, Combitronic communication is a
standard feature on all models. For the Class 6 M-style SmartMotor, Combitronic communication is
currently available only on -EIP option motors. For details, see the Class 6 SmartMotor™
EtherNet/IP Guide.

A large number of the commands provide Combitronic™ support. Combitronic is a protocol that
operates over a standard "CAN" (Controller Area Network) interface. It may coexist with either
CANopen or DeviceNet protocols at the same time. Unlike these common protocols, however,
Combitronic requires no single dedicated controller! to operate. Each Integrated Servo connected to
the same network communicates on an equal footing, sharing all information, and therefore, sharing all
processing resources. For more details on Combitronic features, see Combitronic Communications on
page 113, and also see the overview on the Moog Animatics website at:
https://www.animatics.com/support/combitronic.html.
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Introduction: Combitronic with the DS2020 Combitronic System

For applicable commands, a table row titled "COMBITRONIC" provides the Combitronic command
syntax for addressing a specific SmartMotor in the network. Those commands also display the
Combitronic logo (E2MBIRONIT ") at the top of their reference pages.

abfindex]
P e —
(GCOMBITRONIC] * ab[index]
8-Bit Array Variables
Combitronic Logo Location
FIRNIYWARE VERDIWN. U U g

COMBITRONIC SYNTAX: ab[0]:3=34
where ":3" is thelmotor address; you can use the actual addressor a
variable.

COMBITRONIC: Table Row

Combitronic with the DS2020 Combitronic System

NOTE: DS2020 support requires: 5.0.4.55 (D), 5.98.4.55 (M); 6.4.2.x (D); ds2020 sa 1.0.0 combican
(DS2020).

The Moog Animatics DS2020 Combitronic system is a cabinet mount servo drive connected to a Moog
Compact Dynamic brushless servo motor. Compared to the smaller 17 to 34 frame SmartMotor
products, the DS2020 Combitronic system provides access to a higher torque motor-drive combination,
with torque range and power inputs to include AC mains voltages and motors above 1 KW. However,
similar to other SmartMotor products, the DS2020 Combitronic system has the capability of
responding to Combitronic commands.

The DS2020 Combitronic system is not fully programmable but is connected as a follower device to a
SmartMotor controller. The DS2020 Combitronic system has a CAN address, which you can set through
SMI along with baud rates as you would with any SmartMotor. It is then commanded by the SmartMotor
through Combitronic communications using standard Combitronic syntax, e.g., ADT:3=1234, where "3" is
the CAN address of the DS2020 Combitronic system.

The DS2020 Combitronic system supports a subset of the full AniBasic command set. Supported
commands are primarily Combitronic type, but there are a few others, also. The DS2020 Combitronic
system supported commands are flagged with "; supports the DS2020 Combitronic system" text on the
command's APPLICATION line or READ/REPORT line.

For a list of DS2020 Combitronic system supported commands, see Commands for DS2020
Combitronic on page 967

For details on the DS2020 Combitronic system installation and startup, see the DS2020 Combitronic
Installation and Startup Guide.

1. Moog Animatics has replaced the terms "master" and "slave" with "controller" and "follower",
respectively.
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Communication Lockup Wizard

Improper use of some commands, like Z and OCHN, can lock you out of the motor and prevent further
communication. If you are unable to communicate with the SmartMotor, you may be able to recover
communications using the Communication Lockup Wizard, which is on the SMI software
Communications menu (see the next figure). This tool sends an "E" character to the motor at startup,
which prevents the motor from running its program. For more details on the Communication Lockup
Wizard, see the SMI software online help, which is accessed by pressing the F1 key or selecting Help
from the SMI software main menu.

Communication | Compile Tools Window |

Talk to Motors
~L_ Seﬂingé_______————— —

™Find Motors

Communication Setup Wizard

| Communication Lockup Wizard |

Communication Menu - Communication Lockup Wizard
Safety Information
This section describes the safety symbols and other safety information.

Safety Symbols

The manual may use one or more of these safety symbols:

WARNING: This symbol indicates a potentially nonlethal mechanical hazard, where
failure to comply with the instructions could result in serious injury to the operator

or major damage to the equipment.

CAUTION: This symbol indicates a potentially minor hazard, where failure to
comply with the instructions could result in slight injury to the operator or minor

damage to the equipment.

NOTE: Notes are used to emphasize non-safety concepts or related information.

Other Safety Considerations

The Moog Animatics SmartMotors are supplied as components that are intended for use in an
automated machine or system. As such, it is beyond the scope of this manual to attempt to cover all
the safety standards and considerations that are part of the overall machine/system design and
manufacturing safety. Therefore, this information is intended to be used only as a general guideline for
the machine/system designer.

It is the responsibility of the machine/system designer to perform a thorough "Risk Assessment" and to
ensure that the machine/system and its safeguards comply with the safety standards specified by the
governing authority (for example, ISO, OSHA, UL, etc.) for the site where the machine is being installed
and operated. For more details, see Machine Safety on page 32.
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Introduction: Motor Sizing

Motor Sizing

It is the responsibility of the machine/system designer to select SmartMotors that are properly sized
for the specific application. Undersized motors may: perform poorly, cause excessive downtime or
cause unsafe operating conditions by not being able to handle the loads placed on them. The System
Best Practices document, which is available on the Moog Animatics website, contains information and
equations that can be used for selecting the appropriate motor for the application.

Replacement motors must have the same specifications and firmware version used in the approved and
validated system. Specification changes or firmware upgrades require the approval of the system
designer and may require another Risk Assessment.

Environmental Considerations

It is the responsibility of the machine/system designer to evaluate the intended operating environment
for dust, high-humidity or presence of water (for example, a food-processing environment that requires
water or steam wash down of equipment), corrosives or chemicals that may come in contact with the
machine, etc. Moog Animatics manufactures specialized IP-rated motors for operating in extreme
conditions. For details, see the Moog Animatics Product Catalog.

Machine Safety

In order to protect personnel from any safety hazards in the machine or system, the machine/system
builder must perform a "Risk Assessment”, which is often based on the ISO 13849 standard. The
design/implementation of barriers, emergency stop (E-stop) mechanisms and other safeguards will be
driven by the Risk Assessment and the safety standards specified by the governing authority (for
example, 1SO, OSHA, UL, etc.) for the site where the machine is being installed and operated. The
methodology and details of such an assessment are beyond the scope of this manual. However, there
are various sources of Risk Assessment information available in print and on the internet.

NOTE: The next list is an example of items that would be evaluated when performing the Risk
Assessment. Additional items may be required. The safeguards must ensure the safety of all
personnel who may come in contact with or be in the vicinity of the machine.

In general, the machine/system safeguards must:

» Provide a barrier to prevent unauthorized entry or access to the machine or system. The barrier
must be designed so that personnel cannot reach into any identified danger zones.

» Position the control panel so that it is outside the barrier area but located for an unrestricted
view of the moving mechanism. The control panel must include an E-stop mechanism. Buttons
that start the machine must be protected from accidental activation.

» Provide E-stop mechanisms located at the control panel and at other points around the
perimeter of the barrier that will stop all machine movement when tripped.

» Provide appropriate sensors and interlocks on gates or other points of entry into the protected
zone that will stop all machine movement when tripped.

 Ensure that if a portable control/programming device is supplied (for example, a hand-held
operator/programmer pendant), the device is equipped with an E-stop mechanism.

NOTE: A portable operation/programming device requires many additional system design
considerations and safeguards beyond those listed in this section. For details, see the safety
standards specified by the governing authority (for example, ISO, OSHA, UL, etc.) for the site
where the machine is being installed and operated.

« Prevent contact with moving mechanisms (for example, arms, gears, belts, pulleys, tooling, etc.).
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Introduction: Documentation and Training

» Prevent contact with a part that is thrown from the machine tooling or other part-handling
equipment.

» Prevent contact with any electrical, hydraulic, pneumatic, thermal, chemical or other hazards that
may be present at the machine.
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» Prevent unauthorized access to wiring and power-supply cabinets, electrical boxes, etc.

» Provide a proper control system, program logic and error checking to ensure the safety of all
personnel and equipment (for example, to prevent a run-away condition). The control system
must be designed so that it does not automatically restart the machine/system after a power
failure.

» Prevent unauthorized access or changes to the control system or software.

Documentation and Training

It is the responsibility of the machine/system designer to provide documentation on safety, operation,
maintenance and programming, along with training for all machine operators, maintenance technicians,
programmers, and other personnel who may have access to the machine. This documentation must
include proper lockout/tagout procedures for maintenance and programming operations.

It is the responsibility of the operating company to ensure that:

» All operators, maintenance technicians, programmers and other personnel are tested and
qualified before acquiring access to the machine or system.

» The above personnel perform their assigned functions in a responsible and safe manner to
comply with the procedures in the supplied documentation and the company safety practices.

» The equipment is maintained as described in the documentation and training supplied by the
machine/system designer.

Additional Equipment and Considerations

The Risk Assessment and the operating company's standard safety policies will dictate the need for
additional equipment. In general, it is the responsibility of the operating company to ensure that:

» Unauthorized access to the machine is prevented at all times.

» The personnel are supplied with the proper equipment for the environment and their job
functions, which may include: safety glasses, hearing protection, safety footwear, smocks or
aprons, gloves, hard hats and other protective gear.

» The work area is equipped with proper safety equipment such as first aid equipment, fire
suppression equipment, emergency eye wash and full-body wash stations, etc.

» There are no modifications made to the machine or system without proper engineering
evaluation for design, safety, reliability, etc., and a Risk Assessment.

Safety Information Resources

Additional SmartMotor safety information can be found on the Moog Animatics website; open the topic
"Controls - Notes and Cautions" located at:

https://www.animatics.com/support/downloads/knowledgebase/controls---notes-and-cautions.html

OSHA standards information can be found at:

https://www.osha.gov/law-regs.html
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Introduction: Safety Information Resources

ANSI-RIA robotic safety information can be found at:
http://www.robotics.org/robotic-content.cfm/Robotics/Safety-Compliance/id/23

UL standards information can be found at:
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http://ulstandards.ul.com/standards-catalog/

ISO standards information can be found at:

http://www.iso.org/iso/home/standards.htm

EU standards information can be found at:

http://ec.europa.eu/growth/single-market/european-standards/harmonised-standards/index en.htm
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Introduction: Additional Documents

Additional Documents

The Moog Animatics website contains additional documents that are related to the information in this
manual. Please refer to these lists.

Related Guides

» Moog Animatics SmartMotor™ Installation and Startup Guides

http://www.animatics.com/install-guides

e SmartMotor™ Homing Procedures and Methods Application Note

http://www.animatics.com/homing-application-note

e SmartMotor™ System Best Practices Application Note

http://www.animatics.com/system-best-practices-application-note

In addition to the documents listed above, guides for fieldbus protocols and more can be found on the
website: https://www.animatics.com/support/downloads.manuals.html

Other Documents
e SmartMotor™ Certifications

https://www.animatics.com/certifications.html

o SmartMotor Developer's Worksheet
(interactive tools to assist developer: Scale Factor Calculator, Status Words, CAN Port Status,
Serial Port Status, RMODE Decoder and Syntax Error Codes)

https://www.animatics.com/support/downloads.knowledgebase.html

» Moog Animatics Product Catalog

http://www.animatics.com/support/moog-animatics-catalog.html
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Introduction: Additional Resources

Additional Resources

The Moog Animatics website contains useful resources such as product information, documentation,
product support and more. Please refer to these addresses:
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» General company information:

http://www.animatics.com

e Product information:

http://www.animatics.com/products.html

 Product support (Downloads, How-to Videos, Forums and more):

http://www.animatics.com/support.html

» Contact information, distributor locator tool, inquiries:

https://www.animatics.com/contact-us.html

« Applications (Application Notes and Case Studies):

http://www.animatics.com/applications.html
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Part 1: Programming the SmartMotor

Part 1: Programming the SmartMotor

Part 1 of this guide provides information on programming, SM| software features, communications,
variables, error and fault handling, I/0 control, and other details required for system and application
development.

c
Beginning Programming ... 47 E
Understanding Firmware Versions ... ... 48 o
Downloading and Installing the Latest Firmware ... 48 é—)
Understanding the FIRMWARE VERSION Field in the Command Descriptions ................................... 48 —
Class 5 Firmware for D- and M-Style Motors ... .. ... 48 %
Class 6 Firmware for M-Style (MT/MT2) MOtOrS ... .. . 49 o
Class 6 Firmware for D-Style Motors ... ... 49
DS2020 Combitronic System Firmware .. .. ... 49
Setting the Motor Firmware Version in SMI ... o 50
Setting the Default Firmware Version ... 50
Checking the Default Firmware Version ... 51
Opening the SMI Window (Program Editor) ... 51
Understanding the Program Requirements ... ... ... 52
Creating a "Hello World" Program ... ... e 54
Entering the Program in the SMI Editor ... ... 54
Adding Comments to the Code .. ... 54
Checking the Program SYNtax ..o 54
Saving the Program ... o 55
Downloading a Program to the SmartMotor ... 55
Syntax Checking, Compiling and Downloading the Program ... 55
Additional Notes on Downloaded Programs ..ot 55
Running a Downloaded Program ... .. ... 56
Using the Program Download Window ... 57
Using the Terminal Window and Run Program Button ... 57
Using the RUN Command in the Terminal Window ... 57
Creating a Simple Motion Program ... ... 59
SMI Software Features ... 60
INErOAUCHION oo e e 61
MENU Bar 62
T00 DT 62
Configuration WINOW ... e 64
Terminal WINOW ..o e e 67
Initiating Motion from the Terminal Window ... 69
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Information WINdow ... o 69

Program Editor ... .. 70
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Beginning Programming

This chapter provides information on beginning programming with the SmartMotor. It introduces you to
using the SMI™Program Editor, understanding program requirements, creating a program, downloading
the program and then running it in the SmartMotor. It concludes with a sample for creating your first
motion program.
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Understanding Firmware Versions

Before programming the SmartMotor, it is important that the correct firmware version is installed in
the connected SmartMotor. This topic is intended to help you understand the differences between the
firmware versions.

Downloading and Installing the Latest Firmware

It is recommended that you download and install the latest firmware for your motor. The firmware can
be downloaded from the Moog Animatics website:

https://www.animatics.com/products/smartmotor.resources.html

The firmware files are located in the CAD File and Firmware Downloads section. In addition to the
firmware files, the firmware release notes are available—these provide a succinct description of
changes and enhancements for the corresponding firmware version.

When accessing the firmware downloads, note that firmware files vary depending on your motor's
options (e.g., CAN, PROFIBUS, etc.). Therefore, it is important to check your motor model AND options
before selecting the corresponding file.

To install the downloaded firmware in your SmartMotor, see the instructions in the SMI software online
help.

Understanding the FIRMWARE VERSION Field in the Command Descriptions

The FIRMWARE VERSION field in the command description provides information about the firmware
version(s) that support the command. For example, if the FIRMWARE VERSION field shows "5.x (D/M)",
then the command supports any D- or M-style motor running firmware version 5 and later; if the
FIRMWARE VERSION field shows "6.x (D/M)", then the command supports any D- or M-style motor
running firmware version 6 and later.

In some cases, the FIRMWARE VERSION field shows a specific firmware number, for example,
5.0.4.55/5.98.4.55 (D/M), which means Class 5 D-style version 5.0.4.55 and later, or Class 5 M-style
version 5.98.4.55 and later, are supported.

The next table provides more examples of FIRMWARE VERSION entries and the supported motors.

Firmware Version Examples Supports

5.x (D/M); 6.x (D/M) Class 5 and Class 6 D/M-style motors?

): 6
5.x (D/M); 6.x (D/M); ds2020 sa_1.0.0 combican Class 5 and Class 6 D/M-style motors, and DS2020 Combitronic
(D52020)

5.x (D/M); no Class 6 Class 5 D/M-style motors only, Class 6 not supported

5.x (D/M) requires CAN option; 6.4.2.x (D) Class 5 D/M-style motors with CAN bus, and Class 6 D-style mators?
6.x (D/M); no Class 5 Class 6 D/M-style motors onlyZ, Class 5 not supported

6.x (D/M) requires EPN option; no Class 5 Class 6 D/M-style motors onlyZ with EPN option, Class 5 not supported

1. Class 6 D-style requires ver 6.4.2.x
2. Class 6 D-style includes CAN bus as a standard feature

Class 5 Firmware for D- and M-Style Motors

For Class 5 SmartMotor servos, both D- and M-style, the Class 5 firmware supports most of the
commands described in this guide, except those specific to only Class 6 and/or the DS2020
Combitronic system. Those exceptions are noted on the command description pages.

Class 5 firmware can be identified by the first digit "5" in the firmware version, for example, 5.0.3.2.
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Class 6 Firmware for M-Style (MT/MTZ2) Motors

Noteworthy Class 5 Firmware Versions:

e 5.x.4.x - current public release series of this firmware

o 5.0.4.x series - supports D-style standard and CANopen options models
e 5.16.4.x series - supports D-style DeviceNet option models

e 5.32.4.x series - supports D-style PROFIBUS option models

o 5.97.4.x series - supports M-style DeviceNet option models

e 5.98.4.x series - supports M-style CANopen option models

For additional details, see the Class 5 D-Style Firmware Release Notes and the Class 5 M-Style
Firmware Release Notes.

Class 6 Firmware for M-Style (MT/MT2) Motors

For Class 6 M-style SmartMotor servos, both MT and MT2, the Class 6 MT/MT2 firmware supports
many of the commands described in this guide, except those specific to only Class 5 and/or the
DS52020 Combitronic system. Additionally, there are some commands that are unique to the Class 6
motors. Those exceptions are noted on the command description pages. For more information, see the
topic "Other Class 6 D-Style Changes" in the Class 6 SmartMotor™ Installation and Startup Guide.

Class 6 firmware can be identified by the first digit "6" in the firmware version, for example, 6.0.2.35.
Noteworthy Class 6 MT- and MT2-Series Firmware Versions:

e 6.0.2.x - current public release series of this firmware, provides support for SM23216MH,
SM23166MT, SM23166MT2 and SM34166MT2 motors

For additional details, see the Class 6 - EIP/EEC/EPN Firmware Release Notes.
Class 6 Firmware for D-Style Motors

For Class 6 D-style SmartMotor servos, the firmware supports almost all of the commands described in
this guide, except those specific to DeviceNet, PROFIBUS and I2C (IIC) communications. Those
exceptions are noted on the command description pages. For more information on Class 6 D-style
command and feature limitations, see the topic "Other Class 6 D-Style Changes" in the Class 6 D-Style
SmartMotor™ Installation and Startup Guide.

Class 6 D-style firmware can be identified by the first digit "6" in the firmware version, for example,
6.4.2.1.

Noteworthy Class 6 D-Style Firmware Versions:

e 6.4.2.x - current public release series of this firmware

For additional details, see the Class 6 D-Style Firmware Release Notes.
DS2020 Combitronic System Firmware

For DS2020 Combitronic system, the firmware supports a limited set of SmartMotor commands. The
supported commands are noted on the corresponding command description pages. Also, for a complete
list of supported commands, see Commands for DS2020 Combitronic on page 967.

DS2020 Combitronic system support requires: Class 5 ver. 5.0.4.55 (D-style) or 5.98.4.55 (M-style), or
Class 6 ver. 6.4.2.x (D-style only).

NOTE: The DS2020 Combitronic system is not supported on Class 6 MT/MT2 motors.
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DS2020 Combitronic system firmware can be identified by the terms "ds2020" and "combican" in the
firmware version, for example, ds2020 sa 1.0.0 combican.

Noteworthy DS2020 Combitronic System Firmware Versions:

e ds2020 sa 1.0.0 combican - current public release of this firmware

Setting the Motor Firmware Version in SMI

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

When programming the SmartMotor, it is important that the SMI software compiler's firmware version
setting matches the firmware version of the connected SmartMotor.

CAUTION: The compiler's firmware version must match the firmware version of
the connected motor. If it does not match, the SMI software may not catch syntax

errors and may download incompatible code to the SmartMotor.

This procedure assumes that:

» The SmartMotor is connected to the computer. For details, see Connecting the System in the
SmartMotor Installation & Startup Guide for your motor.

« The SmartMotor is connected to a power source. (Certain models of SmartMotors require
separate control and drive power.) For details, see Understanding the Power Requirements in the
SmartMotor Installation & Startup Guide for your motor.

» The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software in the SmartMotor Installation & Startup Guide for your motor.

Setting the Default Firmware Version

To set the default firmware version, from the SMI software main menu, select:

Compile > Compiler default firmware version
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Setting the Compiler’s Default Firmware Version

From the list, select the firmware version that most closely matches the firmware version of the
connected SmartMotor, as shown in the previous figure. After the default firmware version has been
selected, the list closes.

Checking the Default Firmware Version

To check the default firmware version, from the SMI software main menu, select:
Compile > Compiler default firmware version

On the list, locate the blue dot to the left of the firmware version number. The dot indicates the
currently-selected default firmware version.

Opening the SMI Window (Program Editor)

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

In addition to taking commands over the serial interface, the SmartMotor can run programs. The SMI
window is used to write and edit user programs for the SmartMotor(s). After the program has been
written, it can be checked and then downloaded to the desired SmartMotor(s).

The SMI window is typically closed (default setting) when the SMI software is opened. To open the
window, click the New button ([[]) on the toolbar, or select:

File > New
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SMI Window

After the SMI window opens, you can type your program directly into the editor, or you can copy and
paste existing code from any text-based software such as Windows Notepad.

NOTE: Some word-processing software, such as Microsoft Word, has an option for "smart quotes”,
which use angled single (") and double (”) quotation marks . The angled quotation marks are not
recognized by the SMI editor. Therefore, any "smart quotes” option must be disabled before copying
and pasting the program code.

Understanding the Program Requirements

SmartMotors use a simple form of code called "AniBasic", which is similar to the BASIC programming
language. Various commands include means to create continuous loops, jump to different locations on
given conditions and perform general math functions.

Note these AniBasic program requirements:
» The code is case sensitive:
« All commands begin with or use all UPPER CASE letters.
o All variables are preassigned and must use lower case.
o Command names are reserved and cannot be used as variables.

» A space is a programming element.
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Comments require an apostrophe or ASCII character 39 (') between the commands and the
comment text.

NOTE: When copying and pasting code from another text editor, make sure that your text
editor is not inserting "smart quotes" (angled single or double quotation marks). These are
not the same as ASCII characters 39 (') and 34 ("), and the SMI program editor doesn't
recognize them.

Each program must contain at least one occurrence of the END statement.
Each subroutine call must have a label with a RETURN statement somewhere below it.
Each Interrupt subroutine must end with the RETURNI statement.

The default syntax colors for the SMI editor are: commands (blue), program flow controls (pink),
and comments (green). All other program text is shown in black. You can change the syntax
colors through the Editor tab in the Options window. For details on the Options window, see
SMI Options on page 89.

There is no syntax checking performed until you do one of these:

o From the main menu, select Compile > Scan file for errors
e Select the Scan File for Errors button on the toolbar
e Press Ctrl+F7

As in BASIC, you can use the PRINT command to print to the screen, as shown in the "Hello
World" example. For details, see Creating a "Hello World" Program on page 54.

When the SmartMotor power is turned on, there is a 500 ms "pause" before any program or
command is processed:

« For all industrial networks, every node (or motor) must immediately send out a "Who am
I?" info data packet when power is turned on, which tells the network host who it's talking
to. This is a requirement for all industrial communications protocols (like CANopen,
DeviceNet and PROFIBUS).

» The stored program does not execute until the 500 ms pause expires. Any serial
commands sent during that time are buffered and then accepted after that pause expires.
Because incoming commands take priority over the internal program, any buffered
commands are executed before the internal program begins.

Commands coming in over the network have priority over the program running within the
SmartMotor. For example, while a program is running, you could issue a GOSUB command from
the terminal and send the program off to run the specified subroutine. When the subroutine is
done, the program would resume at the point where the GOSUB command was issued.

The RUN? command can be used at the beginning of a program to prevent it from automatically
running when the SmartMotor power is turned on, as shown in the "Hello World" example. For
details, see Creating a "Hello World" Program on page 54.

o The SmartMotor will not execute any code past the RUN? line until it receives a RUN
command through the serial port.

» Using the serial port, the motor can be commanded to run subroutines even if the stored
program is not running.
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» User programs are stored in the SmartMotor's EEPROM memory. The maximum program size
depends on the motor class you are using:

» For Class 5 motors, the maximum program size is 32767 bytes.
» For Class 6 motors, the maximum program size is 64150 bytes.

For details on downloading user programs to the SmartMotor, see Downloading a Program
to the SmartMotor on page 55 and LOAD on page 548.

Creating a "Hello World" Program
This procedure describes how to create and save a simple "Hello World" program.

NOTE: When copying and pasting code from another text editor, make sure that your text editor is
not inserting "smart quotes" (angled single or double quotation marks). These are not the same as
ASCII characters 39 (') and 34 ("), and the SMI program editor doesn't recognize them.

Entering the Program in the SMI Editor

To create the program, type this code into the SMI software program editor:

RUN?
PRINT ("Hello World", #13)
END

NOTE: The program will not run when the SmartMotor power is turned on (because of the RUN?
command on the first line).

When you run this program, it outputs this text to the Terminal window:
Hello World

To run this program, you must download it to the SmartMotor and then enter the RUN command in the
Terminal window. For more details on downloading the program, see Downloading a Program to the
SmartMotor on page 55. For more details on running the downloaded program, see Running a
Downloaded Program on page 56.

Adding Comments to the Code

You can add comments to the code by inserting a single quotation mark (') between the commands and
your comment text.

NOTE: Comments do not get sent to the SmartMotor.

RUN? 'The program stops here until it receives a RUN command
PRINT ("Hello World", #13) '"#13 is a carriage return
END 'The required END command

Checking the Program Syntax
You can syntax check the program by doing one of these:
o From the main menu, select Compile > Scan file for errors

e Select the Scan File for Errors button on the toolbar

e Press Ctrl+F7
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If errors are found, correct them and re-check the syntax.

The program will also be syntax checked as part of the download procedure. For details, see
Downloading a Program to the SmartMotor on page 55.

Saving the Program

After entering the program, use these steps to save it:

1. From the main menu, select: File > Save As, or click the Save button (&) on the toolbar. The Save
As window opens.

2. Select a drive/folder on your PC or use the default location.
3. Assign a name, such as "HelloWorld.sms".
4. Click Save to write the program to the specified location and close the window.

If you attempt to syntax check or compile and download an unsaved program, the SMI software
automatically opens the Save As window, which requires you to save the program before continuing.

Downloading a Program to the SmartMotor

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

After you've created a program, it must be downloaded to the SmartMotor. This section explains how
to syntax check and download the program.

NOTE: Comments do not get sent to the SmartMotor.

Syntax Checking, Compiling and Downloading the Program

The program can be syntax checked, compiled and transmitted to the SmartMotor in one operation.
To compile the program and then transmit it to the SmartMotor:
NOTE: SMI transmits the compiled version of the program to the SmartMotor.

1. Click the Compile and Download Program button (¥) on the toolbar or press the F5 key. The
Select Motor window opens, which is used to specify which motor(s) will receive the program.

2. Select the desired motor(s) from the list. The SMI software compiles the program during this
step and also checks for errors. If errors are found, make the necessary corrections and try
again.

3. Click OK to close the window and transmit the program. A progress bar shows the status of the
transmission.

Because the SmartMotor's EEPROM (long-term memory) is slow to write, the terminal software uses
two-way communications to regulate the download of a new program.

Additional Notes on Downloaded Programs

Keep these items in mind regarding programs that have been downloaded to the SmartMotor:
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» After the program has been downloaded into the SmartMotor, it remains there until replaced.
» The downloaded program executes every time power is applied to the motor.

o There is a 500 ms timeout before the motor will accept commands on the serial port. Any
commands sent during that time are buffered and then accepted once the 500 ms timeout
expires. Because incoming commands take priority over the internal program, buffered
commands run before the internal program begins.

« If you do not want the program to execute every time power is applied, you must add a
RUN? command as the first line/command of the program. For an example, see Creating a
"Hello World" Program on page 54.

» To get a program to operate continuously, write a loop. For details, see Program Flow
Details on page 185.

« A program cannot be erased; it can only be replaced. To effectively replace a program with
nothing, download a program with only one command: END.

Remember that all programs, even "empty" ones, must contain at least one END command. For
more details on program requirements, see Understanding the Program Requirements on page
52.

Running a Downloaded Program

WARNING: The larger SmartMotors can shake, move quickly and exert great force.
Therefore, proper motor restraints must be used, and safety precautions must be

considered in the workcell design (see Other Safety Considerations on page 31).

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

After the program has downloaded to the SmartMotor, the Program Download window opens, which
contains options relating to running the program.

The pragram was successfully dawnloaded ta the matar.

Click "Run' to run all of the programs for the motors on this
channel. [without chanaing vaniables)

Chck "Rezet" to rezet all of the motors on this channel.
[wariables cleared, program run)

Iv Al Motors on thiz channet

Run Reset Cloze |

| Check to dizable this meszage

Program Download Window

Moog Animatics SmartMotor™ Developer's Guide, Rev. R

Page 56 of 969



Using the Program Download Window

Run will run the program immediately. Reset will clear all user variables and run the program as if it
were power cycled. Close will close the window without running the newly-downloaded program.

"Check to disable this message" will prevent the window from being shown after a program is
downloaded to the SmartMotor. Select that option if you always want to run the program using the
Terminal window and the Run Program in Selected Motor button (®), which is on the SMI software
toolbar.

Using the Program Download Window

(Refer to the previous figure.)

To run the program on all motors:
1. Select the All Motors on this channel option.
2. Click Run.

To run the program on just the selected motor:

1. Deselect the All Motors on this channel option.

2. Click Run.

Using the Terminal Window and Run Program Button

To run the program using the Terminal window and the Run Program button:

1. Use the motor selector in the Terminal window (see the next figure) to select the motor—it must
be the same motor that received the program.

2. Click the Run Program in Selected Motor button (®) to run the program in the selected motor.
m o AT AGE S| >|m © X [HK?

Coml | Ethemet| USE | CaM Ciafnel 0
@ Open |[Motarl Coml _v | Comi 38400 5485, Chi0 BN

| Send

Selected Motor and Run Program Button

Using the RUN Command in the Terminal Window

To run the program using commands in the Terminal window, do one of these:

o Type RUN in the text box and click Send or press Enter

» Type RUN directly on the terminal screen (blue) area and click Send or press Enter.

Moog Animatics SmartMotor™ Developer's Guide, Rev. R
Page 57 of 969



Using the RUN Command in the Terminal Window

Terminal

Coml | Ethemet | USE | CAM Channel 0 |

W Open IM::utu:ur'I Com1 j||:.:m1 ,33400,RS5485,Chi0,8M1

|RUN Send
RUH

RUN Command in the Terminal Window
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Part 1: Programming: Creating a Simple Motion Program

Creating a Simple Motion Program

WARNING: The larger SmartMotors can shake, move quickly and exert great force.
Therefore, proper motor restraints must be used, and safety precautions must be

considered in the workcell design (see Other Safety Considerations on page 31).

Enter this motion program (see below) in the SMI editing window. Pay close attention to spaces and
capitalization.

As described previously, it's only necessary to enter text on the left side of the single quote, as the

text from the single quotation mark to the right end of the line is a comment and for information only.

That said, it is always good programming practice to create well-commented code. Nothing is more
frustrating than trying to debug or decipher code that is sparsely commented.

NOTE: Comments do not get sent to the SmartMotor.

EIGN (2) 'Disable left limit

EIGN (3) 'Disable right limit

ZS 'Reset errors

ADT=100 'Set target accel/decel
VT=1000000 'Set target velocity
PT=100000 'Set target position

G 'Go, starts the move

TWAIT 'Wait for move to complete
PT=0 'Set buffered move back to home
G 'Start motion

END 'End program

After entering the program code, you can download it to the motor and then run it. For details on
downloading the program, see Downloading a Program to the SmartMotor on page 55. For details on
running the downloaded program, see Running a Downloaded Program on page 56.
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Part 1: Programming: SMI Software Features

SMI Software Features

This chapter provides information on SMI software features.

It OdUC I ON . 61

MENU Bar ... 62
=

= T00 DA 62
=

© Configuration WINdow ... 64
o0

e Terminal WInow ... 67

— Initiating Motion from the Terminal Window ... 69
+—

a Information WINdOW ... 69

Program Editor ... 70

MoOtOr ViOW 72

SMI Trace FUNCHIONS .. o 73

Monitor Window ... 76

Serial Data Analyzer ... 78

Chart VW 79

Chart View Example ..o 80

Macros (Keyboard Shortcuts or Hotkeys) ... 83

UL 85

SMI P iONS . 89

SMIHElD o 90

Context-Sensitive Help Using F L .. 90

Context-Sensitive Help Using the Mouse ... ... 90

Help BULTONS L. 90

HOVEr Help o 90

Table of Contents ... o 90

PO O CtS o oo 91

SmartMotor Playground ... 92

Opening the SmartMotor Playground ... 93

Moving the Motor ..o 94
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Part 1: Programming: Introduction

Introduction

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The SMI software interface provides access to a variety of tools that are used to communicate with,
program and monitor the SmartMotor.

The SMI software also provides limited support for the DS2020 Combitronic system. These
tools/features are supported:
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e Tools menu items:

e Macro

e Motor View
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o Chart View
» Configuration tree right-click menu items:
» Motor View
» Set Motor Address
» Configure DS2020

The SMI software interface can be accessed from the Windows Desktop icon or from the Windows
Start menu. For details, see Accessing the SMI Software Interface in the SmartMotor Installation &
Startup Guide for your motor.

(B smarticter Intertece - [sv) B

Menu bar File Edit View Communicstion Compile Tools Window Help
Toolbar Dﬁmﬂﬂ F’“:@,iée gg ﬁwﬁ.!‘@u Plﬁﬂ'%?

ﬁ . / Fisd eioes /r Coml | Ethernet | USB | CAN Channel 0] "@llml ‘ EE
an guratlon " I Open [alboi: - |[Con3 9500RS4SS CROBE—
window = f Sené

/ 5 CAN Channel 01125000 bps]
Terminal
window
Program —
editor
Loration Descrplion
Information
window
For Help, press F1 Version: 5.0.2 NUM Inl, Call

Main Features of the SM| Software
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Part 1: Programming: Menu Bar

NOTE: Depending on your version of SMI software, your screens may look slightly different than
those shown.

The primary software features are briefly described in the next sections. In addition to this information,
there are detailed descriptions of all SMI software features in the software's online help, which can be
accessed from the software's Help menu or by pressing the F1 key.

Menu Bar

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

grammin

The SMI software menu bar provides access to all SMI software features, which are grouped by
functional area.
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Eile Edit VNiew Communication Cormpile Tools Window Help

The Menu Bar

NOTE: Frequently-used features are also available from the SMI software's Toolbar. For details, see
Toolbar on page 62.

Each functional area is described in the next table.

Menu Description

File Access standard file commands (New, Open, Close, etc.).

Edit Edit an SMI program (Cut, Copy, Paste, etc.). Note that an SMI Program Editor
window must be open to use these features.

View Show or hide windows or items in the SMI software interface (Toolbar, Status

bar, Terminal window, etc.).

Control communications with motors (Settings, Detect Motors, Upload Program,

Communication . .
Communication Setup Wizard, etc.).

Scan a program for errors and compile SMX or project files (Scan for errors,

Compile Compile Downloadable SMX file, Compile and Transmit SMX file, Compile Pro-
ject, etc.).
Access SmartMotor tools, monitoring features and options (Macro, Tuner, Motor
Tools . . . .
View, Monitor View, Options, etc.)
. Control the appearance of the SMI software windows (Cascade, Tile Hori-
Window .
zontally/Vertically, Arrange Icons, etc.).
Help Access online help features of the SMI software (Contents, Index, SmartMotor

Programmer's Guide, etc.).

Each menu item is described in detail in the SMI software's online help file, which can be accessed from
the Help menu or by pressing the F1 key.

Toolbar

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

Moog Animatics SmartMotor™ Developer's Guide, Rev. R
Page 62 of 969



Part 1: Programming: Toolbar

The SMI software toolbar provides quick access to the SMI software's frequently-used features. Each
item is represented by an icon, as shown in the next figure.

DeEHE sB28(HE b AT WMEE S » » 6 X\ W

The Toolbar

NOTE: The entire set of SMI software features can be accessed from the menu bar. For details, see
Menu Bar on page 62.

Each icon is described in the next table.

Icon Menu Description
Command

D New Create a new document.

Ew Open Open an existing document.

n Save Save the active document.

ﬁ Save All Save the Project and all open documents.

CH;. Cut Cut the selection and put it on the Clipboard.

EE Copy Copy the selection and put it on the Clipboard.

Paste Insert Clipboard contents.

Configuration

Show or hide the Configuration window.

& o] 7B

i'.r

Terminal

Show or hide the Terminal window.

Information

Show or hide the Information window.

Serial Data Ana-
lyzer

Show or hide the Serial Data Analyzer ("sniffer").

Find Motors

Detect all available motors connected to the defined serial ports of
the computer.

A 30| & [~

-
M

Detect Motors

Detect motors connected to the currently-selected port in the Ter-
minal window.

Compile and Down-
load Project

Compile and download all user programs defined in the project to
their associated motors.

Compile and Trans-
mit SMX File

Compile and download the program in the active view to its asso-
ciated motor.

Scan for errors

Scan the program in the active view.

Upload Program

Upload the program in a motor to an SMI file.

Run Program

Send a RUN command to the selected motor in the Terminal window.

| vi& M S| &7

Stop Running Pro-
gram

Send an END command to the selected motor in the Terminal window.
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Part 1: Programming: Configuration Window

Menu

Icon Command Description
e Stop all Motors Send an END and then an S command to all motors.
;{\ Decelerate all Send an END and then an X command to all motors.

Motors to a Stop

SmartMotor Play- | Opens the SmartMotor Playground, where you can monitor and jog a
ground single motor in Position, Velocity and Torque modes.

%? Context Help Opens the context help for the selected item.

Each item is described in detail in the SMI software's online help file, which can be accessed from the
Help menu or by pressing the F1 key.

Configuration Window

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The Configuration window shows the current configuration and allows access to specific ports and
motors. The Configuration window is essential to keeping multiple SmartMotor systems organized,
especially in the context of developing multiple programs and debugging their operation.

The Configuration window is typically visible when the SMI software opens. If the window has been
closed, you can open it from the SMI software main menu by selecting:

View > Configuration

NOTE: When the window is visible, the menu item will have a check mark next to it.
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Part 1: Programming: Configuration Window

Configuration
Find bators |

EIE Ff_(uiec:t: Projectl
o Fiaf Cormd [R5232-9600 bpz]

- r;’i Coma [R5232-3600 bps)

e £
£ Comé [R5232-9500 bps) =
(% Motorl-Comé [5.0.3.44) ©
----- 4% Motor2-Comi [5.0.3.44) &
Ethernet o

LISE "

(Lo

a

CAM Channel 0 [125000 bpz)

Configuration Window

The Configuration window is essential to keeping multiple SmartMotor systems organized.
To use the Configuration window:
» Click Find Motors to analyze your system, or

Right-click on an available port to display a menu, and select either "detect motors" or "address
motors" to find motors attached to that port.
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Part 1: Programming: Configuration Window

» You can double-click on any port to view its properties, as shown in the next figure.

,y Post la Hubuul

Comem. Type: Pt Hame:
T AS4ES

" Ethsmat Baud Rate:
 USB Paity:

" CANopen Motor Channel; Mobor Ch 0 - I

-
| #hEn Man, Motor Address: |10
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Port Properties Window

» You can also double-click on any motor to open the Motor View tool for that motor, as shown in

the next figure.

Stalus IIrtn | Morior | Us:er\l’aiahlesl Flags | Calculahs‘l Tiace I Nelmnk]

P I REE  Online ADDR:

I Scaled [ Hex Display 1
Pasitior: 20000 Status Word 0w |
Fas. Etrar: 0
Velocily: 0 0@ Drive ready

Mode: Positon 13 Bo: Hufnriﬁnfjf

2 Bt Trajectory in progress
None =] () Bus volage fault
Mane 'I 4 (J B Over-current occurred

52 Bh Excessive temperature faut

~Input/Dutput — Red 24v. Grey Ov — | 6 Q) e Excessive posttion error
01 2 3 45 6 7 70 By velocty imit
QOOOOQOQ 8 Resltime temperature limd

g3 90 defdt error imit

oOe 10 {J Positive HAY Emit enabled

11 3 Negative H'W limit enabled

12 (J Br. Historical positive H/VW limit

13 {J Bl Historical negative HAVY mit

14 (J Bp: Positive HNWV limit asserted

15 Bm: Negative HAW limit asserted

Clear Flags 25) |

Ver: 6.0.1.7 Madel: SM23216MH-NEI

Motor View Window
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Part 1: Programming: Terminal Window

» By right-clicking the motor, you can access its properties along with other tools, as shown in the
next figure.

Motor View
Motor Properties
5et Motor Address

SmartMotor Playground
Clear EEPROM

Upload Program

Tune This Motor
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Azsociate Files to Motor Insert

Download the Program
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Download Main Associated File
Download Firmware
Download .SMEXE File

Validate

Motor Tools Menu

Terminal Window

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The Terminal window acts as a real-time portal between you and the SmartMotor. By typing commands
in the Terminal window, you can set up and execute trajectories, execute subroutines of downloaded
programs and report data and status information to the window.

The Terminal window is typically shown (default setting) when the SMI software is opened. However, if
the Terminal window is closed, select:

View > Terminal

NOTE: When the window is visible, the menu item will have a check mark next to it.

Terminal

Coml | Ethemet| USE | CAN Channel 0|
W Open |Motorl-Coml ||Coml,38400 RS485.Chi0,6M1

| Send |

Terminal Window

To use the Terminal window:
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Part 1: Programming: Terminal Window

» Specific communication ports can be selected using the tabs.

« Commands can be entered in the white text box or directly on the blue screen. If data is flooding
back from the motor, then the white text box will be more convenient, as the incoming data may
cause the text to scroll out of view.

» When motor power is activated, there is a 500 ms timeout before the motor will accept
commands on the serial port. Any commands sent during that time are buffered and then
accepted once the 500 ms timeout expires. Because incoming commands take priority over the
internal program, buffered commands run before the internal program begins.

» Because multiple SmartMotors are on a single communication port are individually addressed,
commands can be routed to any or all of them by making the appropriate selection from the
drop-down list, which is located just below the tabs. The SMI program automatically sends the
appropriate codes to the network to route the data to the specified motor(s).
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 You can double-click a previous command to resend the command (see the next figure). However,
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« If that command has a motor address in it (for example, 1RPA, where "1" = serial bus
Motor 1), the command will resend to that motor.

 |f that command does not have an address, the command will be sent to the last-
addressed motor. For example, if you previously sent the command 2RPA, which
addresses serial bus Motor 2, an unaddressed command that you double-click (or issue)
will go to serial bus Motor 2, even if it's on the list before the point where you started
addressing Motor 2.

An example of commands sent to
the last-addressed motor. Notice
that double-clicking the first RPA
command reports the position of
motor 3 because it was the last-
addressed motor.

« PRINT commands containing data can be sprinkled in programs to send data to the Terminal
window as an aid in debugging.

» What is typed on the screen is not what goes to the motor. For example, 1RPA does not send a
"1" to the motor — it is sending an Extended ASCII code for "1"(Hex 0x81). Then it sends ASCII
"R",'P" and "A", and a SPACE (Hex 20) as the delimiter (not a carriage return). Note that the
terminal window uses a space as the delimiter; the motor uses a carriage return (Hex 0x0D) as
the delimiter.

» Data that has associated report commands, such as Position, which is retrieved using the RPA
command, can be easily reported by simply including the report command directly in the program
code.

NOTE: Be careful when using report commands within tight loops because they can bombard the
Terminal window with too much data.
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Part 1: Programming: Initiating Motion from the Terminal Window

» |f a program is sending too much data to the Terminal window, try adding a WAIT=50 command
to the program, which will slow down the flow.

» Use the right-hand scroll bar to review the Terminal window history.

Initiating Motion from the Terminal Window

WARNING: The larger SmartMotors can shake, move quickly and exert great force.
Therefore, proper motor restraints must be used, and safety precautions must be

considered in the workcell design (see Other Safety Considerations on page 31).

S
£
E
o

To initiate motion from the terminal window, enter these commands (do not enter the comments, which

are the right-hand portion of each line). o
[al

MP 'Initialize Position mode ;;

ADT=100 'Set target accel/decel éE

VT=1000000 'Set target velocity

PT=300000 'Set target position

G 'Go, starts the move

NOTE: Acceleration, velocity and position fully describe a trapezoidal-motion profile.

After the final G command has been entered, the SmartMotor accelerates to speed, slows and then
decelerates to a stop at the absolute target position. The progress can be seen in the Motor View
window. For details on the Motor View window, see Monitoring the SmartMotor Status on page 210.

Information Window

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The Information window shows the program status. When a program is scanned and errors are found,
they are listed in the Information window preceded by a red "E" along with the program path and line
number where the error was found, as shown in the next figure.

Locaton Desenplion

i Seanning "Simpleboves. sme' [500.2]...
E Ch\Documents snd SettngshkwebsterDesklop’SmpleM oves sme(10}  Undelined symbol ' Twaits”,

i Firished. 1 emor, No wamings

For Halp, press Fl Version:5,0.2 Lm 1, Call

Example Error Message

The Information window is typically visible when the SMI software opens. If the window has been
closed, you can open it from the SMI software main menu by selecting:

View > Information
NOTE: When the window is visible, the menu item will have a check mark next to it.

To use the Information window:
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Part 1: Programming: Program Editor

» Double-click on the error in the Information window—the specific error will be located in the
Program Editor.

In the next example, the scanner does not recognize the command TWAITS. The correct
command is TWAIT.

i "

SimpleMoves.sms o[-0 3]

1 RP=3000
= 2 RD=10000
% 3  EI=30
o 4 F
00
o 5  ADT=100
|-
o & VT=1000000
— 7 Cio
s 8 PT=100000
a 9 G

10 THAITS

11 PT=0

12 o

13 TWATT

14 COTO(10)

15 END

PRI P
TWAITS Error

Correct the error and scan the program again. After all errors are corrected, the program can be
downloaded to the SmartMotor.

« Warnings may appear in the Information window to alert you to potential problems. However,
warnings will not prevent the program from being downloaded to the SmartMotor. It is the
programmer’s responsibility to determine the importance of addressing the warnings.

Program Editor

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

SmartMotor programs are written in the SMI software Program Editor before being scanned for errors
and downloaded to the motor.

To open the Program Editor, from the SMI software main menu, select:
File > New

Or click the New button (M) on the toolbar. The Program Editor opens, as shown in the next figure.
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SMIL [ [-E Sl
1
4 I F

Program Editor

To use the Program Editor:

Type the program code directly into the Program Editor. As you write the program, the editor
applies syntax highlighting to the code, which makes it easier to read and debug.

Every program requires an END command, even if the program is designed to run indefinitely and
the END is never reached. For more details on program requirements, see Understanding the
Program Requirements on page 52.

The first time you write a program, you must save it before you can download it to the motor.

Every time a program is downloaded, it is automatically saved to that file name. This point is
important to note, as most Windows applications require a "save" action. If you want to set aside
a certain revision of the program, it should be copied and renamed, or you should simply save the
continued work under a new name.

Once a program is complete, you can scan it for errors by pressing the Scan File button (El) on
the toolbar, or scan and download it in one operation by pressing the Compile and Download
Program button (§4), which is also located on the toolbar.

If errors are found, the download will be aborted and the problems will be identified in the
Information window located at the bottom of the screen.

Programs are scanned using a language file that is related to different motor firmware versions.
If Compile and Download Program is selected, the language file will be chosen based on the
version read from the motor. If Scan File is selected, the default language file will be used. To
change the default language file, from the SMI software main menu, select

Compile > Compiler default firmware version > [select the desired version]

For more details, see Setting the Motor Firmware Version in SMI on page 50.
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Part 1: Programming: Motor View

Motor View
This feature is supports the DS2020 Combitronic system.

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The SMI Motor View window allows you to view multiple parameters related to the motor.
To open the Motor View window, from the SMI software main menu, select:

Tools > Motor View

and select the motor you want to view. Or, in the Configuration window, double-click the motor you

want to view.
i Motor View - “Motorl-Coml! w

Status Ilrm | Moritor | Llser‘faiableg] Flags | Calculatimsl Trace | Nelmnk]

T s | oo |GENIEED AR

r i ™ Hex Display 1
Pozition: 0000 Statuz Ward 0 =
Pas. Eror: ]

Velocily: o 0 @ Drive ready
i Bosiion . 1 Bo: Motor is off

2 0 Bt Trejectory in progress
Hane | 3 Bus volage fautt
Hore 'I 4 3 Ba Owver-current occurred

5 Bh Excessive temperature fault
~Input/Qutput — Fed 24v. GreyOv — | () Be: Excessive postion error
01 2 3 45 B 7 7 By, “elocky lmit
QLQoULUOLOQ 8 O Resi-ime temperature limit
8 95 9 {9 defdt error lmit
O ® 10 ) Positive HAN imit enabled
11 3 Hegative HW limit enabled
12 (3 Br. Historical positive HIVW limit
13 3 Bl Historical negative HAY Emit
14 O Bp: Positive HAY iimit asserted
15 (3 Bm: Negative HAW lmit assered

Clear Flags 25) |

Ver: 6.0.1.7 Madel: SM23216MH-NEI

Motor View Window

NOTE: The Motor View window provides a real-time view into the inner workings of a SmartMotor.
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Part 1: Programming: SMI Trace Functions

To use the Motor View window:

Click Poll to initiate real-time scanning of motor parameters.

A program can be running in the motor while the Motor View window is polling. The program
must not print text to the serial channel being used for polling.

In addition to the standard items displayed, two fields allow you to select from a list of
additional parameters to display.

For example, in the previous figure, Voltage and Current are being polled. This information can
be useful when setting up a system for the first time, or debugging a system in the field.
Temperature is also useful to monitor in applications with demanding loads.

All seven of the user-configurable onboard I/0 points are shown. Any onboard I/0 that is
configured as an output can be toggled by clicking on the dot below the designating number.

The SmartMotor has built-in provisions allowing it to be identified by the SMI software. When a
motor is identified, a picture of it appears in the lower left corner of the Motor View window.

Tabs across the top of the window provide access to additional information.

SMI Trace Functions

The Trace tab provides a set of functions that are useful for debugging a SmartMotor program. To
access Trace functions, open the Motor View window and click the Trace tab.

St,alusl Info | Hurjtl:lrl leur'k-"aiahlusl Flags I Calculation:  Trace ]

~ Mode

* Cumeri
katar Program |5MI2.srrm € About

Stabuz | Mk Connected

Traca Program ISHIE.sms " Befaome

" After
 Continuous

" Slep

" Break at command

Clear Dizplay

-Pa
agram Trace/Step

End Program
Start Trace and
Fur fiorn Beginning

Fiur from Beginning

Start Trace

# | Command | Lire# | Cmd 8| Address

Motor View Trace Functions
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Part 1: Programming: SMI Trace Functions

To use Trace functions:

1.

o v > W

Open the Trace window. When first opened with no program loaded, this message appears:

§ © Motor View - "Motorl-Com1"” @

Status] Irfi ] Mu:unit-:ur] Idzer Uariables] Flags ] Calculations | Trace § Metwork, ]

Double click on the program in Sk that is the zame az the one loaded in the motor. To activate
the trace feature.

Right-click the SmartMotor in the Configuration window and select Upload Program. The
program is uploaded to the SMI Editor.

Double-click anywhere in the program to load it into the Trace window.
Select the desired Mode.
Double-click on desired line in the Editor window, if needed.

Press the desired button in the Trace/Step box. The program must run before anything will
happen.
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The next table describes the

items in the Trace window:

Item

Description

Status box

Shows the current state of the Trace program and Motor Program. This
becomes active after a command is executed on the Trace tab and
remains active until the Motor View is closed. Possible Status messages
are:

Not Connected - Not connected to motor

Program Running or Program Stopped - If at a breakpoint or the
program is stopped.

Trace Active or Trace Inactive - If a trace is currently in progress or
waiting to hit a breakpoint in progress. If a trace is active it must be
canceled before selecting a new Mode.

At Break Point - Program execution halted because a breakpoint was
reached or a step was completed.

Motor Program box

Shows the name of the program contained in the motor.

Trace Program box

Shows the name of the program that was doubled-clicked.

Clear Display button

Clears the highlighted text in the editor window and removes any
information in the Trace List window.

Program group

End Program - Stops program execution by writing the END command
Run from Beginning - Issues a RUN command.

Run Continue - Release firmware from the current breakpoint. (Only
available when at a breakpoint.)

Mode group: For any trace i
the program must run.

nformation to be retrieved from the motor, a mode must be selected and

Current

Captures the first 20 points encountered.

About, Before, After

Requires the user to select a line from the program in the Editor window
by double-clicking on it. The program trace responds based on the
option selected in the Trace/Step group (see below).

About - Captures 9 points before and 10 points after desired line.
Before - captures 20 points before the desired line.

After - Captures 20 points after the desired line.

Continuous Polls the motor for commands that are executing. Because of bandwidth,
not all executed lines are shown in the Trace view or highlighted in the
program.

Step Enables step mode. The program trace responds based on the option

selected in the Trace/Step group (see below).

Break at Command

Requires the user to select a line in the program by double-clicking on it
in the Editor window. The program trace responds based on the option
selected in the Trace/Step group (see descriptions after this table).

Trace/Step group

Various options are available based on other selections (see descrip-

tions after this table).
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Part 1: Programming: Monitor Window

Trace/Step group - Options for trace selections (when Step mode is not selected):

» Start Trace and Run from Beginning button - Sets trace information in the motor and issues a
RUN command.

e Start Trace button - Sets trace information in the motor.

o Start Trace and Run from Current button - Available when at a break point. The trace
information is set in the motor and the program continues from the current break point.

o Cancel Trace button - Available when a trace is active to cancel the current trace.

Trace/Step group - Options for Step (when Step mode is selected):

» Step from Beginning button - Sets a breakpoint in the motor and issues a RUN command. The
program executes the first line of code and then stops.

» Step from Current button - Sets a breakpoint in the motor. If the program is running, the motor
stops at the next command. If the program is at a breakpoint, the motor executes the next
command and then stops.

Trace/Step group - Options for Break (when Break at command mode is selected):

» Set Breakpoint and Run from Beginning button - Sets the breakpoint and runs the program from
the beginning.

o Set Breakpoint button - Sets a breakpoint in the motor.

» Set Breakpoint and Run from Current button - If at a breakpoint, this sets the new breakpoint
and runs the program from the current location.

» Remove Breakpoint button - Removes a breakpoint that was set and not reached.

Monitor Window

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The Monitor window allows you to create your own fully-customized monitor. Because it is polling a
limited set of items, it provides a more efficient monitoring method. To open the Monitor window, from
the SMI software main menu, select:

Tools > Monitor View

. N
D= E g
Stop | | [ Hex Digplay m

Parameter W alue

ﬂ Matar2-Comb Position 0
VIR Mator! -Camb Pasition 1453

Monitor Window
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To use the Monitor window:

» Polling items can be added or removed by pressing the + and - buttons. When adding a new item,
the Add New Monitor Item window opens and provides tools for setting up the monitoring
function, as shown in the next figure.

FAdd new Monitor Hem

hdabar: b mbar2-Ciom
Caplion |Motor2-Come Pasition

grammin

Motor Version:  |5.0.3.44

| Standard Parameters Pozition
Pas. Enai
Status Bits Velocity
| Accelerabon

uiarp__ | Al v

(@]
-
o
—
+—
—
L]
o

Cuztom Patameles |

Pall Cornerard: ™ Bit Mash
[RPA Bitz: |0

Bit Presentation: On DBFCE, icort:
0Tex: [0 When 0 send:

—

Wwhen 1 send

1Test:  |On

MAS Test |N.-'.-'l'-.

Add New Monitor Item Window

» Custom items, which do not have explicit report commands, can be added by entering the
specific commands appropriate to getting the data reported (for example, make a variable equal
to the desired parameter and then report that variable).
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Part 1: Programming: Serial Data Analyzer

Serial Data Analyzer

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The SMI Terminal window formats text and performs other housekeeping functions that are invisible to
the user. For an exact picture of the data being traded between the PC and the SmartMotor™, use the
Serial Data Analyzer (also known as the "sniffer"). To open the Serial Data Analyzer, from the SMI
software main menu, select:

View > Serial Data Analyzer

Or press the Serial Data Analyzer button (®z) on the toolbar. The Serial Data Analyzer window opens,
as shown in the next figure.

Serial Data Analyzer @

Coml | Ethemet | USE | CAM Chanrel 0

=52 55 4E Z0 5 55 4E EZ0 R RUN.. -

I
=50 31 0D | Pl
=50 30 0D | FO.
=45 4E 9% Z0 45 4E 44 EZ0 | END.END.

Send O

Ciata Entry: + Hex " Dec " Char

Serial Data Analyzer

The Serial Data Analyzer window can display serial data in a variety of formats, and it can be a useful
tool for debugging communications. For example, you can:

« View data transfer between computer and SmartMotor(s).

» View data in hexadecimal, decimal, or ASCI| format in up to three columns.
« Send commands and binary data to SmartMotor(s).

» View sent and received data in different definable colors.

» Capture data transfer in different ports at the same time, and view each port using its dedicated
page.

NOTE: SMI can display the precise data being sent between the host and the SmartMotor in multiple
formats.
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Chart View

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

In some cases, the best way to understand a data trend is by seeing it graphically. The SMI Chart View
provides graphical access to any readable SmartMotor parameter.

To open the Chart View window, from the SMI software main menu, select:

Tools > Chart View

grammin

The Chart View window opens, as shown in the next figure.

(&7 Chart View - Chartt I o [ |
AEE $=0 0O)eo|® ¢ =M
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i
Rudes Time: [ i |
Faameter | Last | Average | Min. | Ma< | Fuler [
= MotorT-Coml Pos Enar 4 o 1] B M
= Motor-Com] Poslion 46031 49857 - 95336 MM

Chart View Window

To use the Chart View tool:
« Polling items are added or removed by pressing the + and - buttons.

« The fields and options are identical to those in the Monitor tool. For details on the Monitor tool,
see Monitor Window on page 76.

» Adjustable upper and lower limits for each polled parameter allow them to be scaled to fit the
space.
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« The toolbar across the top provides additional functions such as chart editing, start/stop
sampling, manual update and more.

o The Start Sampling button (») starts the charting action.

» While the Chart View does not include a print function, Window's standard Print Screen key can
capture the chart to the clipboard, and from there, it can be pasted into other applications (like
Microsoft Excel, Microsoft Word, etc.). This graphical data can be a useful addition to written
system reports.

Additionally, a context menu is available by right-clicking on the Chart View window, which has
selections for:

grammin

» Copying the chart data as a tab-delimited table in text format, which can then be imported
into a spreadsheet, such as Microsoft® Excel®, or any text editor.

» Copying the current image of the chart to the clipboard in bitmap format, which can then
be pasted in any graphic application.
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Chart View Example

The SMI Chart View provides graphical access to any readable SmartMotor parameter. The next
example shows how to use the Chart View tool to graphically track torque changes on the SmartMotor.

This procedure assumes that:

« The SmartMotor is connected to the computer. For details, see Connecting the System in the
SmartMotor Installation & Startup Guide for your motor.

« The SmartMotor is connected to a power source. (Certain models of SmartMotors require
separate control and drive power.) For details, see Understanding the Power Requirements in the
SmartMotor Installation & Startup Guide for your motor.

» The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software in the SmartMotor Installation & Startup Guide for your motor.

» You've completed the first-time motion example. For details, see Moving the SmartMotor in the
SmartMotor Installation & Startup Guide for your motor.

To open the Chart View window, from the SMI software main menu, select:
Tools > Chart View

The Chart View window opens. For details, see Chart View on page 79.
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To create the example:

1. Click the Add icon (*). The Add New Chart Item window opens.
2. Click Custom Parameter to enter a nonstandard parameter for charting.

3. Fillin the text boxes as shown in the next figure.

r b
Add new Chart Item ‘ 23
kd akar: IMDh::r'I Cam3 I Add I

S
=
=
o

Captian IHTHE! Cloge | o
o
b atar Yersion: |5.|:|.3.44 Help | —
s
©
Standard Parameters o
Status Bitz
Drigital 1/0

I Cuztom Parameter

— Pall Command: — Bit kazk n

RTRG Bitz: 1]
|

— Bit Prezentation: — On DBIClk icor:
0 Text: ||:|f|= _I When 0 send:

1 Text: IEIn I
When 1 zend:

MG T et |Nm |

S ERI |1E|EIEIEIEI
Minimum:  |-100000

Custom Parameter Button and Related Entries

NOTE: Be sure the Maximum and Minimum values are set to 10000 and -10000, respectively, as
shown in the previous figure. They default to ten times more than those values.
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4. After you've completed the entries, click Add and the custom parameter will be added to the
Chart View window.

5. Click the green Play icon (®); the chart recorder plots the RTRQ value.

6. In the SMI software Terminal window, enter these commands:
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T=0
G

The Chart View tool plots a line similar to the one shown in the next figure.

DEH = D ea|F o EM

Ll
[Param.. Last | Avariage| Min | Max | Ruier

—RTRO 0 B42EE EODD F9EE 0 NAA

RukerTime: [0 1|rﬂ|
[

Plotted RTRQ Values
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7. In the SMI software Terminal window, enter TS=65536. This causes a one-second ramp time
when T is commanded from or to zero.

8. Repeat the previous command sequence. Note the addition of "ramps" to the plot, which are
caused by the TS command.

DEEH =g O e F g =2M

K1

Param.. Last | Aweiage Min | Max | Fues
—RTRG 0 T4 EOD0 TASA Wk

[=le
RusTme: [0 4| b
[

Plotted RTRQ Values With Ramps

Macros (Keyboard Shortcuts or Hotkeys)

NOTE: In addition to the software information in this section, there is context-sensitive help

available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The SMI software contains a Macros tool, which is useful for creating keyboard shortcuts (sometimes
referred to as "hotkeys") for one command or a series of commands for use in the Terminal window.

The tool allows you to optionally associate a command or series of commands with these key
combinations:

e Ctrl+0 to Ctrl+9
e Ctrl+Shift+1 to Ctrl+Shift+9

NOTE: These key combinations can provide shortcuts for up to 19 macros; there is a maximum limit
of 50 macros.

With the Macros tool, you can create multiple macros for a more efficient development process.
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Part 1: Programming: Macros (Keyboard Shortcuts or Hotkeys)

NOTE: In addition to these "shortcuts", SMI also provides a #define preprocessor extension
command that is used to define substitutions for an SMI program. Those substitutions can then be
used within that SMI program. For more details, see the topic "#define (Substitutions)" in the SMI
software online help.

To open the Macros window, from the SMI software main menu, select:
Tools > Macro

The Macros window opens, as shown in the next figure.

Macros — pod
File Help
M ame Dezcription Shorbcut
b acral Send all matars ta 0 Chrl+0
M acrod kove matar 1 1000 counts Chrl+1

Add Delets Run

Macros Window

To use the Macros window:
» Add or remove macros with the Add and Delete buttons.
» Use the Properties button to view and edit the properties of an existing macro.
e The Run button allows you to test the selected macro.
» When you have finished, use the Close button to close the Macros window.

To create a macro:

In this example, you will create a macro for clearing the status bits. For details on clearing the status
bits, see Checking and Clearing Status Bits in the SmartMotor Installation & Startup Guide for your
motor.

1. Open the Macros window.
2. Click Add to open the Add New Macro window (see the next figure).

3. Fillin the information so it looks like the next figure, and then click OK to save the new macro.
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Add Mew Macro ot
kacra Mame: |Disahle Lirnits
Shortcut Eew | Chril+2 ﬂ
Dezcription: |Disable travel limitz and clear faulks

b acro Commands:
EIGRM.O):
25

| 2k | Cancel

Add New Macro

The Ctrl+2 shortcut key combination has now been assigned to the macro Disable Limits. When you
press Ctrl+2, the SMI software issues EIGN(W,0) and ZS to the terminal screen.

Tuner

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

Tuning a SmartMotor is simpler than tuning traditional servos. However, it can be even easier when
using the SMI Tuner tool to see the results of different tuning parameters.

For most applications, the default SmartMotor tuning parameters are sufficient. Viewing the position
error on the Motor View tool and feeling the stiffness of the motor shaft will determine if the motor
requires additional tuning.

Position: 297634
I Paz. Errar: -23

Welocity: -Z25E5EG

Miode: Pozitioh

Position Error

There is a related section on tuning the PID filter later in this manual. If further tuning is required, see
Tuning the PID Control on page 242.
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Part 1: Programming: Tuner

The Tools menu has a GUI-based Tuner tool that can also be used to adjust the tuning parameters. To
open the Tuner tool, from the SMI software main menu, select:

Tools > Tuner

The Tuning window opens, as shown in the next figure.
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Tuning Window

The Tuner graphically shows the step response of the SmartMotor. The step response is the
SmartMotor's actual reaction to a request for a small but instantaneous change in position. (Rotor
inertia prevents the SmartMotor from changing its position in zero time.) The magnitude of the step
response shows how well tuned the motor is.

The Tuner downloads a program that uses variables a, b, p, t, w and z. The program that was in the
motor before tuning and the user variables will be restored after tuning.

Before running the Tuner:

» Be sure the motor and anything it is connected to are free to move about 1000 encoder counts
or more, which is about one-quarter turn of the motor shaft.

» Be sure the device is able to safely withstand an abrupt jolt.

Click the Run Tuning button at the bottom of the Tuner window (see the previous figure).
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If the SmartMotor is connected, is on and is still, you should see results similar to those in the next
figure.

000 BO00
500 5000
] 4000
-500 3000 o
£
-1000 2000 E
1500 1000 =
| —
- 0L
2000 |y ] 3
2500 1000 o
-
-3000 2000 »
. - (10}
3500 3000 a
4000 =400
~J300 =3000
-5000 -5000
[¥] 200

Sample Step Response

The upper curve with the legend on the left is the SmartMotor’s actual position over time. Notice that it
overshot its target position before settling in. Adjusting the PID Tuning will stiffen the motor up and
create less overshoot. For details, see Tuning and PID Control on page 240. In a real-world application,
there will be an acceleration profile, not a demand for instantaneous displacement, so significant
overshoot will not exist. Nevertheless, it is useful to look at the worst-case scenario of a step
response.

To try a different set of tuning parameters, select the Tuning Values tab to the left of the graph area.
As shown in the next figure, you will see a list of tuning parameters with two columns: the left column
lists what is currently in the SmartMotor; the right column provides an area to make changes.
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Tuning Ml:u:le] Setings  Tuning Yalues l

Pator Mew
KPP [Proportional coefficient): |2|:||:||:| |3EII:IEI
Kl (Integral coefficient]: 240 130
KD [Differential cosfficient /5000 10000
KL (Integral fimit} 30000 [32767
é kS [Differential sarmple rate]: |1 |1
© Ky [Welocity feed forwardy 1500 11500
. K |0 [
i k.G [Gravitational coefficient]: |E| |E|
% Copy Values | < Apply Mew Values > |
- Load Saved Yalues | Save Values |

Apply New Values Button

To make adjustments to the tuning:

1. Change the values to those shown in the New column of the previous figure.
2. Click the "Apply New Values" button, which stores the new values in the SmartMotor.
3. Click the Run Tuning button at the bottom of the Tuning window.

The motor will jolt again and the results of the step response will overwrite the previous graph.
Normally, this process involves repeated trials using the procedure outlined in the section on the PID
Filter. For details, see Tuning the PID Control on page 242.

When you are satisfied with the results, the parameters producing the best results can be added to the
top of your program in the SmartMotor, or in applications where there are no programs in the motors,
sent by a host after each power-up. For example, the previous example's tuning parameters would be
set using these tuning commands:

KP=3000
K1=30
KD=10000
KL=32767
F
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SMI Options

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

The SMI software has a variety of options that can be customized through the Options window. It
contains tabs and selections for customizing the Scanner, Editor, Terminal and more.

To open the Options window, select:

Tools > Options

grammin

The Options window opens, as shown in the next figure.
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Options Window

To use the Options window:
» Click a tab to select the options you wish to edit.

» Consider the default firmware version. Because different SmartMotor firmware versions have
subtle differences, the program scanner needs to know which firmware is being used to
distinguish between supported and unsupported commands.

» Other options, such as Editor syntax colors, deal with user preferences.

» After you have finished editing options, click OK to close the window and save your changes.
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Part 1: Programming: SMI Help

SMI Help

The most complete and current information available for the SMI software is available within the
program’s extensive Help tool. For details, see the SMI software help.

Context-Sensitive Help Using F1
» Dialog and Message box: Just press the F1 key while the box is displayed.

» Information View: Select the line and press the F1 key. The software shows a description of the
selected error. For more details, see Information Window on page 69.

» Menu command: Select the menu item and press the F1 key.

» Keyword Information: In the Program Editor, select the keyword and press F1. The software
shows a full description of the selected keyword.

Context-Sensitive Help Using the Mouse

There is a "context help" button on the tool bar. When you click the button (or press Shift+F1 on
keyboard) the program enters the Help Mode and the cursor shape changes to context-sensitive help

cursor ([%?). In Help Mode you can use the mouse or keyboard to select a menu command, a toolbar
button, an error message in the Information View, or other items within SMI, and help on the item is
displayed.

Help Buttons
You can click the Help button, available on many dialog boxes, to get help about that dialog box.
Hover Help

You can place (hover) the mouse pointer over an SMI software button or a Program Editor keyword to
see a short description of that button or keyword.

Table of Contents

To see the list of topics within SMI software Help, use the Contents command in the Help menu.
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Projects

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

In applications with more than one SmartMotor, and possibly more than one program or
communications port, it is helpful to organize all of the elements as a Project rather than deal with
individual files.

NOTE: When working with multiple motors, programs or ports, a Project provides a convenient way
of organizing and using all of the individual elements.

To create a project, from the SMI software main menu, select:
File > New Project

The New Project window opens.
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Part 1: Programming: SmartMotor Playground
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New Project Window

To use the New Project window:

» Enter a name and location in the Project Name and Location fields to title the project and
specify the location where it will be saved.

» Click OK to save the information. At this point, you have the option of letting the SMI software
explore the network of motors and set up the project automatically, or of doing it manually by
double-clicking on the specific communication ports or motors listed in the Information window.
Unless you are you are a system expert and know exactly what the port and motor settings are,
you should let the software detect the motors for you.

» From here, you can open one or more programs for editing in the SMI Editor.
 After the project is set up, select File > Save Project to save it. Projects are saved as .SPJ files.

« To open a project, select File > Open Project, and then select the desired project (.SPJ) file. When
a project file is opened, all motor communication information, program editor windows and other
elements are restored.

» Use the File > Recent Projects menu to view and select from the projects you've most recently
edited.

SmartMotor Playground

NOTE: In addition to the software information in this section, there is context-sensitive help
available within the SMI software interface, which is accessed by pressing the F1 key or selecting
Help from the SMI software main menu.

If you are a first-time user, the SmartMotor Playground contains some simple controls to help you get
started with moving the motor. The SmartMotor Playground allows you to immediately move the motor
without any programming.
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Opening the SmartMotor Playground
There are two ways to access the SmartMotor Playground:
» From within the SMI software interface
o From the Windows Start menu as a stand-alone application.

To access the SmartMotor Playground from the SMI software, in the Configuration window, right-click
the motor you want to move and select SmartMotor Playground from the menu.
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Click Connect (upper-left area of the window) to connect to the SmartMotor.
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Moving the Motor

This procedure assumes that:

» The SmartMotor is connected to the computer. For details, see Connecting the System in the
SmartMotor Installation & Startup Guide for your motor.

« The SmartMotor is connected to a power source. (Certain models of SmartMotors require
separate control and drive power.) For details, see Understanding the Power Requirements in the
SmartMotor Installation & Startup Guide for your motor.

» The SMI software has been installed and is running on the computer. For details, see Installing
the SMI Software in the SmartMotor Installation & Startup Guide for your motor.

e The SmartMotor has been detected and addressed. For details, see Detecting and Addressing
the SmartMotors in the SmartMotor Installation & Startup Guide for your motor.

In addition to the above items:

» Verify that all status bits are off, except for the Drive ready bit, as shown in the previous figure.
If needed, use the Clear Flags button to clear any bits that are on.

» The Drive Enable input on the M-series motor must be connected and activated.

» Verify that Disable Software Limits and Disable Hardware Limits options are set as shown in the
previous figure.

NOTE: The SmartMotor's hardware limits must be grounded or disabled for motion to occur.
Therefore, if your SmartMotor doesn't move when moving the slider or issuing a motion command,
verify that you've either grounded the limits or selected both Disable Hardware Limits check boxes
(located at the lower-right corner of the screen), as shown in the previous figure.
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Within the SmartMotor Playground, you can experiment with the many different modes of operation.
Try these methods (see the previous figure for the locations of these items):

» Click the left and right Jog controls and watch the motor respond.
» Move the position bar to the left or right and watch the motor respond.

« Enter a value (negative = counterclockwise; positive = clockwise) in the Destination box and click
Go. Watch the motor shaft move until the position counter (yellow box) reaches that destination.

While the SmartMotor Playground is useful for moving the motor and learning about its capabilities, to
develop a useful application, you will need to create a program. To learn about programming the
SmartMotor, see Beginning Programming on page 47.
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Part 1: Programming: Communication Details

Communication Details

This chapter provides information on the communications functionality that has been designed into the

SmartMotor.
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Part 1: Programming: Introduction

Introduction
There are various ways to communicate with a SmartMotor:

 Direct-command serial over RS-232 or RS-485 (depending on the motor)
» Data mode

o Combitronic, CANopen, DeviceNet, etc.

e |2C communications

NOTE: When using I°C, the SmartMotor is always the bus controller. You cannot communicate
between SmartMotors through I2C.

These communications methods are described in the next sections.

In applications using more than one SmartMotor, the best choice for communications is to link the
SmartMotors together over their optional CAN ports, and then communicate with the group through
any of the RS-232 or RS-485 ports of any of the motors on the chain. The SmartMotor's CAN-based
Combitronic communications unifies all SmartMotor data and functions in a group, which makes any
single motor look like a multi-axis controller from the perspective of the RS-232 or RS-485 ports.
Additionally, this allows all the motors to share resources as though they were a large multi-axis
controller.

Moog Animatics offers adapters for
converting RS-232 to RS-485, and for
converting either to USB.

NOTE: If you are unable to communicate with the SmartMotor, you may be able to recover
communications using the Communication Lockup Wizard, which is on the SMI software
Communications menu. For details, see the SMI software online help, which is accessed by pressing
the F1 key or selecting Help from the SMI software main menu.

[Communication] Compile Tools Window |
Talk to Motors

S o ———

n otars

[/

Communication Setup Wizard

I Communication Lockup Wizard I

Communication Menu - Communication Lockup Wizard
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Connecting to a Host

The default mode for communicating with a Class 5 or Class 6 D-style SmartMotor is serial RS-232;
Class 5 and Class 6 M-style SmartMotors use serial RS-485.

NOTE: The M-style motors have one RS-485 port; they do not have an R5-232 port.

For D-style motors, the most common and cost-effective solution is through RS-232 serial
communications. Under this structure, each motor is placed in an electrical serial connection such that
the transmit line of one motor is connected to the receive line of the next. Each motor is set to echo
incoming data to the next motor down with approximately 1 millisecond propagation delay. There is no
signal integrity loss from one motor to the next, which results in highly-reliable communications.

NOTE: To maximize the flexibility of the SmartMotor, all serial ports are fully programmable with
regard to bit rate and protocol.

There is a 31-byte input buffer for the RS-232 port and another for the RS-485 port. These buffers
ensure that no arriving information is ever lost. However, when either port is in data mode, it is the
responsibility of the user program within the SmartMotor to keep up with the incoming data.

Cable to Host PC Class 5 & 6 D-Style
DE9 Female Attach shield at PCend (D)

’ ®
'l (3 RS-232 Tx
(9 RS-232 Rx
() RS-232 GND *+~

b 1
@ m @ © () Serva Power (+)
9 6 12 Power GND

FOWER TW2 Female Combo D-sub

Connection Between a Class 5 or Class 6 D-style SmartMotor and Host PC

The CBLSM1-3M cable
makes quick work of con-
necting to your first
RS-232-based SmartMotor.
It combines the connections
for communications and
power into one cable
assembly.
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Part 1: Programming: Daisy Chaining Multiple D-Style SmartMotors over RS-232

By default, the primary channel, which shares a connector with the incoming power in some versions, is
set up as a command port with these characteristics:

Other
Default Options
Type: RS-232 RS-485
Parity: None Odd or Even
Bit Rate: 9600 2400 to 115200
Stop Bits: 1 Oor2
Data Bits: 8 7
Mode: Command Data
Echo: Off On

Also, note that:

 |f the cable used is not provided by Moog Animatics, make sure the SmartMotor's power and
RS-232 connections are correct.

CAUTION: Be sure to use shielded cable to connect RS-232 ports, with the shield
ground connected to pin 5 (ground) of the PC end only.

» Buffers on both sides mean there is no need for any handshaking protocol when commanding the
SmartMotor.

» Most commands execute in less time than it takes to receive the next one. Therefore, be careful
to allow processes time to complete, particularly for slower processes like printing to an LCD
display or executing a full subroutine.

Daisy Chaining Multiple D-Style SmartMotors over RS-232

This section describes how to daisy chain multiple D-style SmartMotors to a single RS-232 port as
shown in the next figure. Other SmartMotors can be connected together in a daisy-chain or multi-drop
fashion. For details, see Connecting the System in the SmartMotor Installation & Startup Guide for
your motor.

For low-power motors (size SM23165D and smaller), as many as 100 motors could be cascaded using
the daisy-chaining technique for R5-232. To operate independently, each motor must be programmed
with a unique address. In a multiple-motor system, the programmer has the choice of putting a host
computer in control or having the first motor in the chain be in control of the rest.
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1 2 3 4

O OB OO T = |

@ @ @ @ 3 U

sCEDs | RS-2327Tx RS-232 Tx
RS-232 Rx - (9 RS-232 Rx

[ J
@ o

\— Rs-232GND () @ @ (G RS-232 GND +—/ £
Servo Power (+) &) Servo Power (+) E
Power GND (2 @ @ (22 Power GND .
Attach shield at PC end a
o
©
T DI :
DE9 Female POWER

Daisy-Chain Connection between D-Style SmartMotors and Host PC

NOTE: You can build your own RS-232 daisy-chain cable or purchase Add-A-Motor cables from
Moog Animatics.

Fully-molded Add-A-Motor cables
make quick work of daisy-chaining
multiple motors over an RS-232 net-
work.

CAUTION: Large (size 23 or size 34) SmartMotors draw so much power that

they often require isolated communications for reliability. For such applications,
consider using a DIN Rail R5-232 communication breakout device. For
assistance, contact Moog Animatics.

The next sections describe related commands. For more details on these commands, see Part 2:
SmartMotor Command Reference on page 247.
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Part 1: Programming: ADDR=formula

ADDR=formula
Set Motor to New Address

The ADDR= command causes a SmartMotor to respond exclusively to serial commands addressed to it.
It is separate and independent of the motor's CAN address. The address number range is from 1 to
120.

When each motor in a chain has a unique address, an individual motor communicates normally after its
address is sent over the chain one time. To send an address, add 128 to its value and output the binary
result over the communication link. This puts the value above the ASCII character set, which
differentiates it from all other commands or data. The address needs to be sent only once until the
host computer, or motor, wants to change it to something else.

Sending out an address zero (128) causes all motors to listen and is an efficient way to send global
data such as a G for starting simultaneous motion in a chain. Once set, the address features work the
same for RS-232 and RS-485 communications.

RS-232 Daisy-Chained SmartMotors

Unlike the RS-485 star topology, the consecutive nature of the RS-232 daisy chain creates the
opportunity for the chain to be independently addressed entirely from the host, rather than by having a
uniquely-addressed program in each motor. Setting up a system this way adds simplicity because the
program in each motor can be exactly the same. If the RUN? command is the first in each of the motor’s
programs, the programs will not start when the SmartMotor power is turned on. Addressing can then be
worked out by the host before the programs are later initiated through a global RUN command.

SLEEP, SLEEP1

Assert sleep mode

WAKE, WAKE1
Deassert SLEEP

The SLEEP command causes the motor to ignore all commands except the WAKE command. This
feature can often be useful, particularly when establishing unique addresses in a chain of motors. The 1
at the end of commands specifies the AniLink RS-485 port.

NOTE: The SmartMotor can be made to automatically ECHO received characters to the next
SmartMotor in a daisy chain
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ECHO, ECHO1
ECHO input

ECHO OFF, ECHO OFF1
Deassert ECHO

The ECHO and ECHO OFF commands toggle (turn on/off) the echoing of data input. Because the motors
do not echo character input by default, consecutive commands can be presented, configuring them with
unique addresses, one at a time. If the host computer or controller sent out the next command
sequence, each motor would have a unique and consecutive address.

If a daisy chain of SmartMotors has been powered off and back on, the next commands can be entered
into the SmartMotor Interface to address the motors (0 equals 128, 1 equals 129, etc.). Some delay
should be inserted between commands when sending them from a host computer.

0SADDRI1
1ECHO
1SLEEP
0SADDR2
2ECHO
2SLEEP
0SADDR3
3ECHO
OWAKE

Commanded by a user program in the first motor instead of a host, the same daisy chain could be
addressed with this sequence:

SADDR1 'Address the first motor

ECHO 'Echo for host data

PRINT (#128, "SADDR2", #13) 'OSADDR2
WAIT=10 'Allow time
PRINT (#130, "ECHO", #13) '2ECHO
WAIT=10

PRINT (#130, "SLEEP", #13) '2SLEEP
WAIT=10

PRINT (#128, "SADDR3", #13) 'OSADDR3
WAIT=10

PRINT (#131, "ECHO", #13) ' 3ECHO
WAIT=10

PRINT (#128, "WAKE", #13) ' OWAKE
WAIT=10
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Part 1: Programming: Serial Commands

Serial Commands

The SmartMotor allows you to communicate over the available RS-232 and/or RS-485 serial ports
(depending on the style of SmartMotor you're using). There are specific serial commands used for
configuring the serial communications, baud rate, printing, etc., as described below.

NOTE: D-style SmartMotors use primarily R5-232 communications, whereas all other SmartMotor
use primarily RS-485 communications.

The next sections describe related commands. For more details on these commands, see Part 2:
SmartMotor Command Reference on page 247.

OCHN(type,channel,parity,bit rate,stop bits,data bits,mode,timeout)

Option Description
type: RS2 (D-style RS2=RS-232, R54=RS5-485, MB4=Modbus pro-
only), RS4, tocol over RS-485*, DMX=DMX protocol*
MB4, DMX
channel: D-style: 0, 1 0=Main, 1=Secondary
M-style: 0
parity N, O, or E None, Odd or Even

bit rate: 2400, 4800, 9600, 19200, 38400, 57600, 115200 baud
stop bits: 1 or 2
data bits: 8
mode: Cor D Command or Data

timeout: (Optional) Timeout in milliseconds between issuing a command and
detecting a delimiter, e.g., RPA(space) where space is the delimiter.

*For more details, see the documentation for the specified protocol.

NOTE: Changing the default value of any parameter other than baud rate will prevent proper
command data from being received by the SmartMotor. If you are unable to communicate with the
SmartMotor, you may be able to recover communications using the Communication Lockup Wizard,
which is on the SMI software Communication menu. For details, see the SMI software online help,
which is accessed by pressing the F1 key or selecting Help from the SMI software main menu.

Placing a communications port in Data mode will completely prevent the SmartMotor from receiving
any commands and require the user program code to parse out all incoming data. Therefore, if the
intent is to be able to send standard commands at any time and allow the SMI software to detect the
motors, then the OCHN command could be used to change only the baud rate or the communications
error timeout values — do not use it to change any other settings. The BAUD command can also be
used to change the baud rate. For details, see BAUDrate, BAUD(channel)=formula on page 105.

This is an example of the OCHN command:

OCHN (RS4,0,N,38400,1,8,D)
For a D-style motor, if the primary communication channel (0) is opened as an RS-485 port, then it
assumes the Moog Animatics RS485-1S0 adapter is connected to it. If so, then I/0 6 is used to direct
the adapter to be in transmit or receive mode according to the motor's communication activity, and I/0
6 will no longer be used as an /O communications port. M-style motors are supplied with R5-485 on

COM 0; D-style motors require an adapter for R5-485 on COM 0, but they have built-in RS-485
available on COM 1.
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CCHN(type,channel)

Close a communications channel
Use the CCHN command to close a communications port when desired.

NOTE: If you are unable to communicate with the SmartMotor, you may be able to recover
communications using the Communication Lockup Wizard, which is on the SMI software
Communication menu. For details, see the SMI software online help, which is accessed by pressing
the F1 key or selecting Help from the SMI software main menu.

BAUDrate, BAUD(channel)=formula
Set BAUD rate (RS-232 and RS-485)

The BAUD command sets the speed or baud rate of the specified serial channel. To do this, use:

rammin
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« BAUD(channel)=formula: sets the baud rate of the specified serial channel

where rate and formula are the desired baud rate, and (channel) is 0 or 1 for channel O or channel 1,
respectively. Valid values for rate and formula are: 2400, 4800, 9600, 19200, 38400, 57600, or
115200. For additional motor-specific details, see Product-Specific Table on page 303.

PRINT(), PRINTL()
Print to RS-232 or AniLink channel
A variety of data formats can exist within the parentheses of the PRINT() command.
» A text string is marked as such by enclosing it between double quotation marks.

» Variables can be placed between the parentheses as well as two variables separated by one
operator.

» To send out a specific byte value, prefix the value with the # sign and represent the value with as
many as three decimal digits ranging from 0 to 255.

« Multiple types of data can be sent in a single PRINT() statement by separating the entries with
commas.

NOTE: Do not use spaces outside of text strings because the SmartMotor uses spaces,
carriage returns and line feeds as delimiters.

These are all valid print statements that transmit data through the main RS-232 channel:

PRINT ("Hello World") 'text
PRINT (a*b) 'exp.
PRINT (#32) 'data
PRINT ("A",a,a*b, #13) "all

PRINTI prints to the AniLink port with RS-485 protocol.
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Part 1: Programming: SILENT, SILENT1

SILENT, SILENT1
Suppress PRINT() outputs

TALK, TALK1

Deassert Silent Mode

The SILENT mode causes all PRINT() output to be suppressed. This is useful when talking to a chain of
motors from a host, when the chain would otherwise be talking within itself because of programs
executing that contain PRINT() commands. The TALK and TALK1 commands restore print messaging.

a=CHN(channel)

Communication Error Flags

Where channel can be 0 or 1 for COM Channel O or 1. It holds binary coded information about historical
errors on the two communications channels.

The command gives the 5-bit status of either serial port channel 0 or 1, as described in the next table.

Bit Value Meaning

0 1 Buffer overflow
1 2 Framing error

2 4 N/A

3 8 Parity error

4 16 Timeout occurred

The next example subroutine prints errors to an LCD display.

Cc9
IF CHN (0) 'If CHNO != 0O
IF CHN(0) &1
PRINT ("BUFFER OVERFLOW")
ENDIF
IF CHN(0) &2
PRINT ("FRAMING ERROR")
ENDIF
IF CHN(O0) &8
PRINT ("PARITY ERROR")
ENDIF
IF CHN(0)&l6
PRINT ("TIMEOUT OCCURRED")
ENDIF
72(2,0) 'Reset CHNO errors
ENDIF
RETURN
a=ADDR
Motor’s Self Address

If the motor’'s address (ADDR) is set by an external source, it may still be useful for the program in the
motor to know to what address it is set. When a motor is set to an address, the ADDR variable reflects
that address — the range is from 1 to 120.
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Communicating over RS-485

Multiple SmartMotors can be connected to a single host port by connecting their RS-485 A signals
together and B signals together, and then connecting them to an RS-485 port or to an RS-232 or USB
adapter.

Adapters provided by Moog Animatics have built-in biasing resistors. However, extensive networks
should add bias at the very last motor in the chain. The RS-485 signals of the SmartMotor share I/0
functions and are not properly biased for more than just a few SmartMotors. Additionally, proper
cabling would include a shielded twisted pair for transmission.

The main R5-232 ports of the D-style
SmartMotors can be converted to
RS-485 and isolated using Moog
Animatics adapters.

The RS-232 and RS-485 ports have many configuration possibilities. To set the configuration options,
use the OCHN command, which is described in the next section.

Using Data Mode

Data mode is used to retrieve data from the RS-232/RS-485 port.

If a communications port is in Command mode, then the motor responds to arriving commands it
recognizes. However, if the port is opened in Data mode, then incoming data fills the 16-byte buffer
until it is retrieved with the GETCHR command.

For D-style motors:

a=LEN Number of characters in RS-232 buffer
a=LEN1 Number of characters in RS-485 buffer
a=GETCHR Get character from RS-232 buffer

a=GETCHR1 Get character from RS-485 buffer
For M-style motors:

a=LEN Number of characters in RS-485 buffer
a=GETCHR Get character from RS-485 buffer

The buffer is a standard FIFO (First In First Out) buffer. This means that if the letter A is the first
character the buffer receives, then it will be the first byte offered to the GETCHR command. The buffer
exists to make sure that no data is lost, even if the program is not retrieving the data at just the right
time.

The GETCHR buffer will stop accepting characters if the buffer overflows, and RLEN will stop
incrementing. Also, the overflow bit will be set for that serial channel. When the buffer is empty,
GETCHR will return a value of (negative 1.) If GETCHR is assigned to a byte ab[], then the value gets
cast from the range -1 to +255 to the signed range -128 to +127. This causes -1 (empty buffer) to have
the same value as char 255, since 255 gets cast to -1. It is recommended you assign GETCHR to a word
or long to perform comparisons.

The LEN variable holds the number of characters in the buffer. A program must see that the LEN is
greater than zero before issuing a command like a=GETCHR. Likewise, it is necessary to arrange the
application so that, overall, data will be pulled out of the buffer as fast as it comes in.
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Part 1: Programming: Using Data Mode

The ability to configure the communication ports for any protocol as well as to both transmit and
receive data allows the SmartMotor to interface with a vast array of RS-232 and R5-485 devices.
Some of the typical devices that would interface with SmartMotors over the communication interface
are:

o Other SmartMotors

» Bar Code Readers

» Light Curtains

» Terminals

e Printers
The next example program repeatedly transmits a message to an external device (in this case another
SmartMotor) and then takes a number back from the device as a series of ASCII letter digits, each

ranging from O to 9. A carriage return character marks the end of the received data. The program uses
that data as a move position.

AT=500 'Preset acceleration.
VT=1000000 'Preset velocity
PT=0 'Zero out position.
0=0 'Declare origin

G 'Servo in place

OCHN (RS2, 0,N,9600,1,8,D)
PRINT ("RPA", #13)

Co
IF LEN 'Check for chars
a=GETCHR 'Get char
IF a==13 'If carriage return
G 'Start motion
PT=0 'Reset buffered P to zero
PRINT ("RP", #13) 'Next
ELSE PT=PT*10 'Shift buffered P
a=a—-48 'Adjust for ASCII
PT=PT+a 'Build buffered P
ENDIF
ENDIF
GOTO (0) 'Loop forever

The ASCII code for zero is 48. The other nine digits count up from there so the ASCII code can be
converted to a useful number by subtracting the value of 0 (ASCII 48). The example assumes that the
most significant digits will be returned first. Any time it sees a new digit, it multiplies the previous
quantity by 10 to shift it over and then adds the new digit as the least significant one. After a carriage
return is seen (ASCII 13), motion starts. After motion starts, P (Position) is reset to zero in preparation
for building up again. P is buffered, so it will not do anything until the G command is issued.

The SmartMotor has a wealth of data that can be retrieved over the Combitronic, RS-232 and R5-485
ports simply by asking. Data and status reporting commands can be tested by issuing these report
commands from any hosting application. Using SMI Terminal window as the host (see the next figure),
the command is shown on the left and the SmartMotor's response is shown in the middle.
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SmartMotor Command with Response

The SMI host software uses these commands to implement the Motor View window and Monitor View
tools. Data that does not have direct report commands can be retrieved either of two ways, by
embedding the variable in a PRINT command, or by setting a variable equal to the parameter and then
reporting the variable. For more details, see Part 2: SmartMotor Command Reference on page 247.

It is important to note that Combitronic reports only work if the CAN network is wired to each motor,
and the CAN addresses and baud rate are configured. Keep in mind:

» Unique addresses must be assigned to each motor with the CADDR command.

» All motors on the same CAN network must be configured to the same baud rate with the CBAUD
command.
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Part 1: Programming: CAN Communications

CAN Communications
NOTE: DeviceNet is currently not available on the Class 6 SmartMotor.

The SmartMotor supports different protocols over the CAN port if equipped. CANopen and DeviceNet
are popular industrial networks that use CAN. If a controller is communicating to a group of
SmartMotors as follower devices through either of these standard protocols, the Combitronic protocol
can still function without being seen by the CANopen or DeviceNet controller.

NOTE: The CAN network must have all devices set to the same baud rate to operate.

For more details about the CANopen implementation on the SmartMotor, see the CANopen fieldbus
guide for your SmartMotor.

The next sections describe related commands. For more details on these commands, see Part 2:
SmartMotor Command Reference on page 247.

CADDR=formula

Set CAN address

Where formula may be from 1 to 127. The setting is stored in the EEPROM. However, for it to take
effect, the user must cycle power to the motor.

CBAUD=formula
Set CAN baud rate

Where formula may be one of these: 1000000, 800000, 500000, 250000, 125000, 100000, 50000,
20000. The setting is stored in the EEPROM. However, for it to take effect, the user must cycle power
to the motor.

=CAN, =CAN(arg)
Get CAN error

The CAN command is used to get (read) an error or other status information about the CAN bus. For
example:

RCAN(0), x=CAN(0): Report/get status bits relating to CAN.
RCAN(1), x=CAN(1): Report/get the current NMT state of this motor.

RCAN(4), x=CAN(4): Report/get the result code of the most recent SDO read or write, or NMT
command as a controller.

For more details, see CAN, CAN(arg) on page 357.

Specific features are based on the fieldbus network being used. See the corresponding SmartMotor
fieldbus guide for more details.

CANCTL(function,value)
Control network features
Commands execute based on the function argument to control CAN functions. For example:

function = 1: Reset the CAN MAC and all errors. Resets the CANopen stack, PROFIBUS stack or
DeviceNet stack depending on firmware type. Value is ignored.

function = 5: Set timeout for Combitronic. Value is in milliseconds; the default is 30.
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function = 16: Set the SDO command timeout period. In milliseconds. Range is 10 to 1000. Default is
500 (1/2 second).

function = 17: Enables the controller commands: NMT, SDORD and SDOWR. Enable simple controller: x
is the value 3; disable controller: x is the value -1.

For more details, see CANCTL(function,value) on page 359.

Specific features are based on the fieldbus network being used. See the corresponding SmartMotor
fieldbus guide for more details.

=
=
SDORD(...) =
©
Read value from SDO -
.. . . . —
The SDORD command gets (reads) the value from the specified SDO on a specified device. o
—
EXAMPLE: Read an SDO +
©
x=SDORD (1, 24592,0,2) ' Read 2 bytes from address 1, o
' object 0x6010, sub-index O.
e=CAN (4) ' Get any error information
y=SDORD (1, 24608,0,2) ' Read 2 bytes from address 1,
' object 0x6020, sub-index 0.
ee=CAN (4) ' Get any error information
IF (elee)== ' Confirm the status of both SDO operations.
' Success
b=x ' Set some example variable according
c=y ' to the data received.
GOSUB (3) ' Some routine to take action when this data is valid.
ELSE
GOSUB(8) ' Go do something to deal with error when read fails.
ENDIF

For more details, see SDORD(...) on page 730.

SDOWR(...)
Write value to SDO
The SDOWR command writes a value to the specified SDO on a specified device.

EXAMPLE: Write an SDO

a=1234
SDOWR (1, 9029,0,4,a) ' Write 4 bytes to address 1,
IF CAN(4)== ' Confirm the status of the most recent SDO operation.
' Success

GOSUB (4) ' Some routine to take action when the write succeeds.
ELSE

GOSUB (9) ' Go do something to deal with error when write fails.
ENDIF

For more details, see SDOWR(...) on page 732.
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Part 1: Programming: NMT

NMT

Transmit NMT message to network

The NMT command transmits an NMT message to the network; it can command either a specific or all
follower devices to enter the commanded state. The command uses the form:

NMT(target address, desired state)

NMT (0, 1) 'Tell everyone to go operational.
NMT (2,128) 'Tell motor 2 to go pre-operational.
x=CAN (4)
IF x!=0

' NMT command failed.
ENDIF

For more details, see NMT on page 626.
RB(2,4), x=B(2,4)
Determine if CAN error has occurred

Report/get if an error state has occurred over CAN, CANopen or Combitronic. Further investigation
through RCAN(O) will give more details. This can be cleared using the Z(2,4) or ZS command.

For more details, see B(word,bit) on page 297.
Exceptions to NMT, SDORD and SDOWR Commands
Note these exceptions when using the NMT, SDORD, SDOWR commands:

nn

« No Combitronic version of these commands, i.e., there is no ":" operator form of the command,
for example:
x=SDORD(...):3
is not allowed. Refer to each command's description in Part 2 of this guide.

» No monitoring the heartbeat of other network nodes.

» No special commands for sending or receiving PDOs. PDOs must be mapped to existing objects
to send or receive data as a follower device. Even the SmartMotor designated as a controller
must configure its own PDO mappings.

NOTE: SmartMotors currently have 5 transmit and 5 receive PDOs.

» No capability to read EDS files. The user is responsible for writing a program with the relevant
object index, sub-index and data type.

o No LSS host behavior is provided from the SmartMotor. Each follower device is expected to
have the properly configured address and baud rate. Each device must have a unique address; all
devices must use the same baud rate. Any need to set the baud rate or address is not the
responsibility of Moog Animatics.

e Only one SmartMotor may fill the controller role. No other SmartMotors on the network may
issue these commands, because this implementation does not support a multi-CANopen-
controller functionality.

« No support for controller read/write of segmented or block SDO protocol. Only Expedited (32-
bit or smaller) data transmission are supported by the controller functionality.
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I/0 Device CAN Bus Controller

Many Moog Animatics SmartMotor servos, with appropriate firmware, can interface with standard CiA
301 CANopen devices, such as CANopen valve blocks, CANopen I/0 blocks, CANopen encoders, and
many other devices. This means through CAN and Combitronic communications, you now have full
machine control with just a SmartMotor as the bus controller—no other external bus controller is
required. This capability is enabled by the CAN communications commands (NMT, SDORD and SDOWR)
described previously in this section, and new/modified objects.

NOTE: This capability is not available on all SmartMotor servos — for availability, see the
SmartMotor Installation & Startup Guide for your motor or contact Moog Animatics.

Basic control allows 8, 16, or 32-bit sized data objects with support for both PDO and SDO protocols.
The supported profiles include but are not limited to I/O profile, encoder profile, and DS4xx profile.
This provides the ability to:

» Dynamically map SmartMotor PDOs, map another device's PDOs, start the NMT state
« A SmartMotor can send/receive up to 5 PDOs each or Rx (receive) and Tx (transmit)
« Read/write SDOs in expedited mode only, which works for up to 32-bit data

Multiple SmartMotors and multiple I/O devices may be on the same CAN bus. This combined with
Combitronic motor-to-motor communications allows for complex, multi-axis, multi-I/O-device network
control. Refer to the next figure.

;/4'* CANopen Motor to |/ok:\ fi--} EomBITRONIC)™ Motor to Motor\fi \ Without data collision! \
= > e > <~ —
tormingior > > > > > taminaior
+ + [+ +[4 + 1[4 + +[4
4 v |+ v+ 4 v |+ 4 v |+
CANopen SmartMotor SmartMotor CANopen SmartMotor CANopen SmartMotor

ABS Encoder Valve Block Remote 1/0

Be sure to comply with the guidelines for CAN bus cabling and termination.

SmartMotor as |/0 Device CAN Bus Controller

Related CANopen objects are: 2220h, 2221h and 2204h. For more details, refer to the object
descriptions in the Object Reference chapter of the SmartMotor CANopen Guide.

Related commands are: NMT, SDORD, SDOWR, CANCTL, and B/RB. For details, see the brief
descriptions in this section and the detailed descriptions in Part 2 of this guide.
Example user programs are shown in the Part 3 of this guide:

e CAN Bus - Timed SDO Poll on page 879
« CAN Bus - I/0 Block with PDO Poll on page 880

Combitronic Communications

NOTE: For the Class 5 D- and M-style SmartMotors, Combitronic communication is available on
models with the -CAN option. For the Class 6 D-style SmartMotor, Combitronic communication is a
standard feature on all models. For the Class 6 M-style SmartMotor, Combitronic communication is
currently available only on -EIP option motors. For details, see the Class 6 SmartMotor™
EtherNet/IP Guide.
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Part 1: Programming: Combitronic Features

The most unique feature of the SmartMotor is its ability to communicate with other SmartMotors and
share resources using Moog Animatics’ Combitronic™ technology. Combitronic is a protocol that
operates over a standard "CAN" (Controller Area Network) interface. It may coexist with either
CANopen or DeviceNet protocols at the same time. It requires no single dedicated controller to
operate. Each SmartMotor connected to the same network communicates on an equal footing, sharing
all information, and therefore, sharing all processing resources.

The optional Combitronic technology allows any motor's program to read from, write to or control any
other motor simply by tagging a local variable or command with the other motor's CAN address. To do
this, take any Combitronic-supported SmartMotor command, add a colon and then a number
representing the address of another SmartMotor on the same CAN bus, and that parameter belongs to
that SmartMotor.

grammin

For example, imagine you have three SmartMotors linked together and set with addresses 1, 2 and 3.
These examples show how Combitronic communications works:

» This typical line of code, written in SmartMotor number 2, sets a target position in that same
SmartMotor:
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PT=4000 'Set Target Position in local motor

 This line of code, written in SmartMotor number 2, or any of the three motors, sets a target
position in SmartMotor number 3:

PT:3=4000 'Set Target Position in motor 3

» The Combitronic global address for all SmartMotors is zero, so the next line of code, written in
any SmartMotor, sets the target position in all SmartMotors at the same time:

PT:0=4000 'Set Target Position in all motors

e This line of code could be written in motor number 1 and set variable "a" in motor number 2
equal to an I/O of motor number 3:

a:2=IN(0):3 'Set variable in 2 to I/O of 3

For a complete list of Combitronic commands, see Commands for Combitronic on page 963.

Combitronic Features
e 127 addressable nodes
1 Mbps over the CAN bus

No controller required

» No scan list or node list set up required

All nodes have full read/write access to all other nodes

Other Combitronic Benefits

Combitronic technology provides a simple way to create a true parallel-processing environment.
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e PLCs (Programmable Logic Controllers) can be eliminated, due to the speed of program
execution within the SmartMotor, combined with the speed of the Combitronic communications
and the power of the SmartMotor's programming language.

e Sensors and valves can be connected to the closest SmartMotor in the machine and be available
to the program of any SmartMotor on the network.

« An HMI (Human Machine Interface) can connect to any one or more of the SmartMotor's RS-232
or RS-485 ports and provide visibility into the entire network.

» The size and complexity of the machine collapses to the point where, in many cases, there is no
longer even a cabinet.

As aresult, the machine builder is spared the traditional bulk, failure modes, wiring time and
complexity, and costs of separate servo controllers, servo amplifiers and PLCs.

Program Loops with Combitronic

Keep in mind that while Combitronic communications are very fast, program execution is also very fast.
Therefore, if a tight loop is written with a Combitronic transaction inside, you will flood the CAN bus
with data, which can slow the operations of all SmartMotors on the chain.

CAUTION: Tight loops with Combitronic commands can flood the CAN bus with
data and impair the function of a SmartMotor network. For the best performance,

structure programs to minimize disturbance of the CAN infrastructure.

This problem can be avoided. For example, if motor 1 needs to poll the state of an input on motor 2,
then instead of writing a tight loop with a Combitronic command in it:

1. Write a tight loop in motor 2 that executes a Combitronic transmission only when that input
changes state.

2. Issue a Combitronic command in motor 2 that sets a variable in motor 1 in the event of the input
state change.

3. Program motor 1 to poll its own internal variable.

This way, the actual polling activity is not occupying the CAN bus.

NOTE: A key to powerful programing in SmartMotors is to exploit parallel processing for throughput
without unnecessary polling over the Combitronic interface, which needlessly wastes throughput.

Global Combitronic Transmissions

Global Combitronic transmissions are especially fast because they do not involve node responses at
the protocol level. This fact can be leveraged to speed applications by having certain motors globally
broadcast infrequent but relevant state changes. For example, if a machine had a "door" and that door
could be opened or closed, the motor performing that function could set every motor's variable "d"
equal to 1 when the door is opened and 0 when the door is closed, like this:

The program in each motor can simply check its own variable "d" for the status of the door. Through
this technique, the programmer has created a new type of "global" variable.

A clever way to program a network of SmartMotors is to write one program and download that same
program to all motors. Then have the program first look to the motor's CAN address and execute only
the portion of the controller program that pertains to that motor address. This makes supporting a
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Part 1: Programming: Simplify Machine Support

large network much easier because there is only one program. Make sure "global" variables, as created

in the previous example, are all unique.

Simplify Machine Support

Combitronic features can also be used to simplify the support of a SmartMotor-based machine. To do

this:

1. Allocate a small group of 1/0, or the analog value of an input, to be unique in each motor position
through the wiring leading to that motor.

2. Have the program set its CAN address in accordance with that unique input status.

With this technique, a spare SmartMotor containing the controller program could quickly replace any
failed motor in the system without any special configuration. Even its own address would be

automatically set.

Combitronic with RS-232 Interface

Any SmartMotor may be used as a controller access through RS-232 to all SmartMotors on its network.
The next figure demonstrates 12 motors in a network where four SmartMotors are in a serial daisy
chain over RS-232. Each of those four banks may have up to 119 motors on its Combitronic network.

RS-232
Bank 1
Controlling
PC
Combitronic
Controller
Motor 2

Combitronic
Follower

!

Motor 3

Combitronic
Follower

Bank 2

Combitronic
Controller

!

Motor 2

Combitronic
Follower

!

Motor 3

Combitronic
Follower

Bank 3

Combitronic
Controller

!

Motor 2

Combitronic
Follower

!

Motor 3

Combitronic
Follower

RS-232 and Combitronic Networks

Bank 4

Combitronic
Controller

!

Motor 2

Combitronic
Follower

!

Motor 3

Combitronic
Follower

Example SMI software commands from the host PC RS-232 port for the system layout in the previous

figure:
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Part 1: Programming: Combitronic with the DS2020 Combitronic System

2PT:3=1234 Motor 2 sets target position of Motor 3 in its group to 1234

3PT:0=0 Motor 3 sets target position of all motors in its group to zero

4PT=345 Motor 4, only, gets its own target position set to 345

0G Motor 1, 2, 3 and 4 receive Go command

0G:0 All motors on RS-232 and all network Combitronic motors receive Go command

Combitronic with the DS2020 Combitronic System

NOTE: DS2020 support requires: 5.0.4.55 (D), 5.98.4.55 (M); 6.4.2.x (D); ds2020 sa 1.0.0 combican
(DS2020).

The Moog Animatics DS2020 Combitronic system is a cabinet mount servo drive connected to a Moog
Compact Dynamic brushless servo motor. Compared to the smaller 17 to 34 frame SmartMotor
products, the DS2020 Combitronic system provides access to a higher torque motor-drive combination,
with torque range and power inputs to include AC mains voltages and motors above 1 KW. However,
similar to other SmartMotor products, the DS2020 Combitronic system has the capability of
responding to Combitronic commands.

The DS2020 Combitronic system is not fully programmable but is connected as a follower device to a
SmartMotor controller. The DS2020 Combitronic system has a CAN address, which you can set through
SMI along with baud rates as you would with any SmartMotor. It is then commanded by the SmartMotor
through Combitronic communications using standard Combitronic syntax, e.g., ADT:3=1234, where "3" is
the CAN address of the DS2020 Combitronic system.

The DS2020 Combitronic system supports a subset of the full AniBasic command set. Supported
commands are primarily Combitronic type, but there are a few others, also. The DS2020 Combitronic
system supported commands are flagged with "; supports the DS2020 Combitronic system" text on the
command's APPLICATION line or READ/REPORT line.

For a list of DS2020 Combitronic system supported commands, see Commands for DS2020
Combitronic on page 967

For details on the DS2020 Combitronic system installation and startup, see the DS2020 Combitronic
Installation and Startup Guide.
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Part 1: Programming: Other CAN Protocols

Other CAN Protocols

This section briefly describes two other supported CAN protocols: CANopen and DeviceNet.
NOTE: DeviceNet is currently not available on the Class 6 SmartMotor.

CANopen - CAN Bus Protocol

CANopen is an industrial CAN bus protocol supported on SmartMotors ordered with the CANopen
option. The protocol supports the CiA 402 profile for drives and motion devices. The hosting controller
can use an EDS file supplied by Moog Animatics that provides control of the SmartMotor over the
CANopen network.

One of the more powerful features of the CIA 402 profile is Interpolation mode, which is supported by
both the CANopen-enabled SmartMotor and Moog Animatics’ own coordinated-motion software, SMNC
and Integrated Motion DLL. By itself, the Integrated Motion DLL offers the host-application developer
the means to control SmartMotors using CANopen.

DeviceNet - CAN Bus Protocol

NOTE: DeviceNet is currently not available on the Class 6 SmartMotor.

DeviceNet is an industrial CAN bus protocol supported in the SmartMotor with optional firmware. The
protocol supports the Common Industrial Protocol (CIP) profile for a position controller. The hosting
controller can use an Electronic Data Sheet (EDS) file supplied by Moog Animatics that allows the
SmartMotor to be controlled through DeviceNet.

I2C Communications (Class 5 D-Style Motors)

The Class 5 D-style SmartMotors provide open I2C (IIC) communications capabilities, which expand the
capabilities of that SmartMotor.

NOTE: I2C communications is not currently available on the Class 5 M-style or any Class 6
SmartMotor.

The I2C capability is comprised of two signals, SDA and SCL, on ports 4 and 5 of the 15-pin D-sub
connector, respectively. These ports are most often shared with the SmartMotor's RS-485 ports.
Therefore, to set up I12C communications, a choice must be made between I12C and R5-485
communications.

There are I12C devices that perform dozens of functions, such as nonvolatile memory, high resolution A-
to-D and D-to-A conversion, analog and digital /0O expansion and more.

The next program example shows how to use |*C communications with a small EEPROM memory device
known as the 24FC512. Only the initialization part runs at power-up. Thereafter, subroutines 100 and
200 can be called to write or read data into the EEPROM.
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' Class 5 I2C EEPROM Test 00

' Sept 10, 2009

' I2C test for 24FC512 EEPROM on Personality Module
' Address 1010 001 x

R R EE R R R R R R R R R
SADDR1

ECHO

Co

OFF 'Turn off drive stage power
OCHN(IIC,1,N,200000,1,8,D) '"Initialize I/0s 4 and 5 as IIC port
PRINT (#13,"IIC Port Initialized", #13)

PRINT (#13)

END

grammin

C100 'Write variable a at pointer p

al[0]=a

al[l]l=p

PRINT (#13)

PRINT ("Load ",al[0]," at pos ",p,#13)

PRINT1 (IIS, #160,#ab[5],#ab[4],#ab[3],#ab[2],#ab[1],#ab[0],IIP)
PRINT ("Load bytes: ",ab[3],", ",ab[2],", ",abI[1l],", ",ab[0],#13)
PRINT (#13)

(@]
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RETURN

C200 'Read into variable a at pointer p

al[ll=p

PRINT1 (IIS, #160,#ab[5],#ab[4],I1IP) 'Write memory pointer

WAIT=1 'Must have small wait to give the write time it needs
PRINT1 (IIS,#161,IIG4,IIP) 'Setup to read four bytes
WAIT=1 'Must have small wait to give the write time it needs

ab[3]=GETCHR1

ab[2]=GETCHR1

ab[1]=GETCHR1

ab[0]=GETCHR1

a=al[0]

PRINT (#13)

PRINT ("Read bytes: ",ab[3],", ",ab[2],", ",abIl1l],", ",ab[0],#13)
PRINT ("Read ",a," at pos ",p,#13)

PRINT (#13)

RETURN

The next sections describe related commands. For more details on these commands, see Part 2:
SmartMotor Command Reference on page 247.
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OCHN(IIC,1,N,baud,1,8,D)

The OCHN command is used to set the |2C communication parameters:

[1C Literal syntax IIC to tell what kind of communication this is
1 Literal value 1, since this is the location of that port
N Literal, not relevant to IIC

p= baud Bit rate for communication with the IIC device

g 1 Literal, not relevant to I1C

© 8 Literal, not relevant to IIC

. D Literal, always in data mode for IIC communication

a

— CCHN(lIC,1)

t

a The CCHN(IIC,1) command is simply used to close the 12C communications channel.

PRINT1(argl,arg2, ... ,arg n)

Where arg is:
s Start or restart an IIC command. For IIC devices that require a restart, simply
call the IIS command a second time within a PRINT command.
[P Stop an IIC command.
[1Gn Get n bytes from the IIC channel (requires the previous commands to have

provided whatever addressing or command is required for the device to start
sending). The G argument provides the right number of clock intervals to
acquire the data from the I1C device.

RGETCHRI1, Var=GETCHR1

Returns data from the IIC device (if available). The data is always in unsigned byte values, so assign the
data to a 16 or 32-bit register first in order to test for special cases.

For example, the value is 0-255 for normal data, which represents all possible values for the byte. If
the value from the GETCHR1 command is -1, it means the buffer is empty.

RLEN1, Var=LEN1

Gets the number of bytes in the receive buffer.
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Motion Details

This chapter provides details on making motion with the SmartMotor.
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Introduction

All SmartMotor™ commands are grouped by function with these notations:

# Numerical integer value, constrained by command. For example, O,
1,.22.
formula (or frm) Formula or number. For example, 123 or a=1 or a=(2*3)-1.
= expression (or exp) Simple expression or number. For example, a+3 or al[1] or 5.
g W (Capital W letter by itself.) Refers to "Word", or 16 bits of inform-
© ation. Option for addressing /O 16-bit status words.
o mask (or msk) The mask value of the bits that will be affected when working with

integers can typically be passed into a command as an expression.
Mainly used for I/0 and status word bit manipulations. For details on
binary data, see Binary Data on page 900.

(@)
.
o
\;i
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(o]
o

NOTE: In the command syntax, when optional bracketed arguments are shown, the comma within the
brackets is only used with the optional argument. For example, the comma is used with the optional
"m/s" argument in the command MFSLEW(distance[,m/s]).

Enter these commands in the Terminal window to move the SmartMotor:

EIGN (2) 'Disable left limit
EIGN (3) 'Disable right limit

ZS 'Reset errors

ADT=100 'Set target accel/decel
VT=100000 'Set target velocity
PT=300000 'Set target position

G 'Go, starts the move

NOTE: As shown in the example, a complete move requires: a position, a velocity and an
acceleration, and then a G (Go) command to start the move.

On power-up the motor defaults to position mode. Once Acceleration-Deceleration Target (ADT) and
Velocity Target (VT) are set, simply issue new Position Target (PT) commands, and then a Go (G)
command to execute moves to new absolute locations. The motor does not instantly go to the
programmed position but uses a trajectory to get there. The trajectory is bound by the maximum target
velocity and target acceleration parameters. The result is a trapezoidal velocity profile, or a triangular
profile if the maximum velocity is never met.

NOTE: Position, velocity and acceleration can be changed at any time during or between moves.
However, the new parameters only apply when a new G command is sent.

NOTE: Many motion commands and related report commands are affected by the scaling commands
(SCALEA, SCALEP and SCALEV). For details, see SCALEA(m,d) on page 724, SCALEP(m,d) on page
726, and SCALEV(m,d) on page 728. For the list of SCALE-affected commands, see Commands
Affected by SCALE on page 903.
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Motion Command Quick Reference

The next table provides a quick reference for the primary Class 5 motion commands. For the complete
list of motion control commands and links to their descriptions, see Motion Control on page 957.

DE/Dt Over

Accel and

Absqll_Jte Rela‘lt‘ive Velocity Decel Accel Decel Following Derivative  Speed
Position Position Error L L
Together Error Limit  Limit
Report Actual RPA RPRA RVA N/A N/A REA RDEA
Report | End Target RPT RPRT RVT RAT RAT | RDT REL RDEL RVL
Report | Commanded RPC RPRC RVC RAC RAC
Assign | End Target PT= PRT= VT= ADT= AT= DT=
Assign Command N/A N/A N/A N/A N/A N/A EL= DEL= VL=

In the chart above, you will notice Actual, End Target, and Commanded:

o Actual: The value of the parameter as the processor sees it in real time at the shaft, regardless
of anything commanded by the trajectory generator

« Target: The requested trajectory target to reach and/or maintain at any given time

» Commanded: The compensated value of the trajectory generator at any time in its attempt to
reach the target

For example, in terms of the position commands:

« Position Target (PT): The desired target position you are shooting for; what you have specified
as a target position value

« Position Actual (PA): The current position in real time (right now), regardless of target or where
it is being told to go

« Position Commanded (PC): The position the controller processor is actually commanding it to go
to at the time

NOTE: Any difference between Position Commanded (PC) and Position Actual (PA) is due to position
error.

There are two position types:

o Absolute: The finite position value in reference to position zero
» Relative: A relative distance from the present position at the time

All commands shown above are associated with both Mode Position (MP) and Mode Velocity (MV). They
may also be used in dual trajectory mode when running either of those modes on top of gearing or
camming.

All distance parameters are in encoder counts. Encoder resolution may be obtained and used in a
program through the RES command. The RRES command will report encoder resolution. You can also
use the RES command directly in math formulas.

EXAMPLE:
If you want it the axis to move to location 1234, then you would issue:

PT=1234
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Part 1: Programming: Basic Motion Commands

While moving there:
» RPC would report the commanded position from the processor.
» RPA would report actual position of the encoder or motor shaft.
» x=PC-PA would calculate position error at that moment.
» REA would report actual position error at that moment.
« RBt would report a 1 (while moving) because the trajectory is active.

After the move has completed, RBt would report a O (to indicate the trajectory is no longer active).

Basic Motion Commands

The basic motion commands described in this section are used to set the operating mode, control
acceleration/deceleration, velocity, torque, origin and position, and to start and stop the motion. Use
the Motion Command Quick Reference on page 895 to understand the relationship between basic
motion commands and the terms Actual, Commanded and Target.

Target Commands

The section describes target-related commands. For more details on these commands, see Part 2:
SmartMotor Command Reference on page 247.

PT=formula

Set Target Position (Absolute)

The PT command sets an absolute end position to move to when the motor is in Position mode. The
units are encoder counts and can be positive or negative in the range -2147483648 to +2147483647.
It is not advisable to attempt to use absolute moves that would cross the rollover point of the most
positive and most negative values. Also, absolute moves should not attempt to specify a move with a
relative distance of more than 2147483647. The end position can be set or changed at any time during
or at the end of previous moves. SmartMotor™ sizes 17 and 23 resolve 4000 increments per revolution,
while SmartMotor size 34 resolves 8000 increments per revolution.

The next program illustrates how variables can be used to set motion values to real-world units and
have the working values scaled in motor units for a size 17 or 23 SmartMotor.

a=100 'Acceleration in rev/sec*sec

v=1 'Velocity in rev/sec

p=100 'Position in revs

GOSUB(10) 'Initiate motion

END 'End program

C10 'Motion routine
ADT=a*4.096 'Set target accel/decel
VT=v*32768 'Set target velocity
PT=p*4000 'Set target position
G 'Start move

RETURN 'Return to call

NOTE: If any errors exist, they must be cleared before the G command will work. All errors can be
cleared with the ZS command.
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PRT=formula

Set Relative Target Position

The PRT command allows a relative-distance move to be specified when the motor is in position mode.
The value indicates the encoder counts to travel; it must be within the range of -2147483648 to
+2147483647. This relative distance is added to the current trajectory position and not the actual
position either during or after a move. If a previous move is still in progress, then the current trajectory
position is added to when G is commanded. If the total distance traveled needs to directly correspond
to the number of moves made, make sure a move has finished before issuing another G command.

ADT=formula

Set Target Acceleration/Deceleration

Target Acceleration/Deceleration must be a positive integer within the range of 0 to 2147483647. The
default is zero, so a nonzero number must be entered to initiate motion. A typical value is 100. This
command sets acceleration and deceleration of the motion profile to the value specified. This value can
be changed at any time. The value set does not take effect until the next G command is executed.
Native acceleration units are

(counts/sample/sample)*65536. The default sample rate for Class 5 is 8.0 kHz; the default sample rate
for Class 6 is 16.0 kHz.

AT=formula
Set Target Acceleration Only
DT=formula

Set Target Deceleration Only

The AT and DT commands allow setting different values for the acceleration and deceleration of the
motion profile, respectively. Standard practice should be to use the ADT command instead unless
separate values are needed. There is an override that automatically sets DT equal to AT if the motor
power is turned on and only AT is set. However, this should be avoided by using the ADT command
when DT is not used.

To convert acceleration in revolutions per second? to units of ADT, AT or DT, use this formula:
ADT = Acceleration * ((enc. counts per rev.)/(sample rate?)) * 65536

If the motor has a 4000 count encoder (sizes 17 and 23), multiply the desired acceleration, in rev/sec?,
by 4.096 to arrive at the appropriate setting for ADT. With an 8000 count encoder (size 34), the
multiplier is 8.192. These factors assume a PID rate of 8.0 kHz, which is the default.

Note that ADT, AT and DT allow only even numbers. When odd numbers are used, they are rounded up.
The default values are zero.

VT=formula

Set Target Velocity

The VT command specifies a target velocity (speed and direction) for velocity moves, or a slew speed
for position moves. The value must be in the range -2147483647 to 2147483647. Note that in position
moves, this value is the unsigned speed of the move and does not imply direction. The value set by the
VT command only governs the calculated trajectory of MP and MV modes (position and velocity). In
either of these modes, the PID compensator may need to "catch up" if the actual position falls behind
the trajectory position. In this case, the actual speed exceeds the target speed. The value defaults to
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Part 1: Programming: Motion Mode Commands

zero, so it must be set before any motion can take place. The new value does not take effect until the
next G command is issued.

To convert velocity in revolutions per second to units of VT, use this formula:
VT = Velocity * ((enc. counts per rev.)/(sample rate)) * 65536

If the motor has a 4000 count encoder (sizes 17 and 23), multiply the desired velocity in rev/sec by
32768 to arrive at the setting for VT. With an 8000 count encoder (size 34), the multiplier is 65536.
These factors assume a PID rate of 8.0 kHz, which is the default.

Motion Mode Commands

The section describes motion-mode commands. For more details on these commands, see Part 2:
SmartMotor Command Reference on page 247.

MP

Position Mode

Issuing the Mode Position (MP) command puts the SmartMotor in Position mode. Position mode is the
default mode of operation for the SmartMotor on power-up. In Position mode, the PT, PRT, VT, ADT, AT
and DT commands can be used to govern motion. At a minimum, ADT, VT and (PT or PRT) must be
issued.

MV
Velocity Mode

The Mode Velocity (MV) command allows continuous rotation of the motor shaft. In Velocity mode, the
programmed position using the PT or the PRT commands is ignored. Acceleration and velocity need to
be specified using the ADT and the VT commands. After a G command is issued, the motor accelerates
up to the programmed velocity and continues at that velocity indefinitely. Similar to Position mode, in
Velocity mode, velocity and acceleration are changeable on the fly, at any time — simply specify new
values and enter another G command to trigger the change. In Velocity mode, the velocity can be
entered as a negative number, unlike in Position mode where the location of the target position
determines velocity direction or sign. If the 32-bit register that holds position rolls over in Velocity
mode, it will have no effect on the motion.

Velocity mode calculates its trajectory as an ideal position over time and corrects the resulting
measured position error instead of measuring velocity error. This is significant in that this mode will
"catch up" lost position, just as Position mode will if a disturbance causes a lagging position error.

MT

Torque Mode

The Mode Torque (MT) command puts the SmartMotor in Torque mode. In Torque mode, the motor
applies a PWM commutation effort to the motor proportional to the T command and independent of
position. If the motor model has a current-control commutation mode, then torque is controlled in
proportion to the T command. Otherwise, torque depends on the actual motor speed and bus voltage,
eventually reaching an equilibrium speed. Nevertheless, for a locked rotor, the torque will be largely
proportional to the T value and bus voltage.

To run the motor in Torque mode, use the T command and issue a G command for the new torque value
to take effect.

NOTE: You must issue a G command for a new torque value to take effect in Torque mode.
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Internal encoder tracking still takes place and can be read by a host or program. However, the value will
be ignored for motion because the PID loop is inactive.

Torque Commands

These commands set the torque slope and value. For more details on these commands, see Part 2:
SmartMotor Command Reference on page 247.

TS=formula

Set Torque Slope

The TS= command causes new torque settings to be reached gradually, rather than instantly. Values
may be from -1 to +2147483647. -1 disables the slope feature and causes new torque values to be
reached immediately. A TS setting of 65536 increases the output torque by one unit per PID sample
period.

T=formula

Set Torque Value, -32767 to 32767

In Torque mode, activated by the MT command, the drive duty cycle can be set with the T= command.
The value (number or variable) must fall in the range from-32767 to 32767. The full-scale value relates
to full-scale or maximum-duty cycle. At a given speed, there will be reasonable correlation between
drive duty cycle and torque. With nothing loading the shaft, the T= command will dictate open-loop
speed. A G command must be entered after the T= command for the new value to take effect.

The next example increases torque, one unit every PID sample period, up to 8000 units.

MT 'Select torque mode.

T=8000 'Final torque after the TS ramp that we want.
TS=65536 'Increase the torque by 1 unit of T per PID sample.
G 'Begin move

Brake Commands

These commands control the brake functions for the motion. For more details on these commands, see
Part 2: SmartMotor Command Reference on page 247.

BRKRLS

Brake Release - manual override command

Mechanically disengages brake (regardless of the brake operational mode)

BRKENG

Brake Engage - manual override command
Mechanically engages brake (regardless of the brake operational mode)

NOTE: When BRKSRV or BRKTRJ is issued after a manual override command has been issued, the
brake will respond to the state of automatic control of the mode chosen.
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Part 1: Programming: BRKSRV

BRKSRV

Automatically Release Brake Only When Servo Active

(Default mode of operation) causes brake to mechanically engage when: the motor faults (for any
reason), OFF is issued, or the drive is already in OFF state.

BRKTRIJ

Automatically Release Brake Only When in Trajectory

(Optional mode of operation) causes brake to mechanically engage any time the Trajectory bit is off
and brake to release any time the trajectory bit turns on.

The SmartMotor is available with power-loss brakes. These brakes apply a force to keep the shaft from
rotating should the SmartMotor lose power. Issuing the BRKRLS command releases the brake and
BRKENG engages it. There are two other commands that initiate automated operating modes for the
brake. The command BRKSRV engages the brake automatically, should the motor stop servoing and no
longer hold position for any reason. This event might be due to loss of power or just a position error,
limit fault or overtemperature fault.

Finally, the BRKTRJ command engages the brake in response to all of the previously-mentioned events,
including any time the motor is not performing a trajectory. In this mode the motor is off and the brake
holds it in position rather than the motor servoing when it is at rest. As soon as another trajectory is
started, the brake releases. The time it takes for the brake to engage and release is only a few
milliseconds.

The brakes used in the SmartMotor are zero-backlash devices with extremely long life spans. It is well
within their capabilities to operate interactively within an application. However, take care to avoid a
situation where the brake sets repeatedly during motion, which will reduce the brake life.

Where a SmartMotor is not equipped with a physical brake, it simulates braking with its Mode Torque
Brake (MTB) feature, which causes a faulted motor to still experience strong resistance to shaft
motion. Note that MTB only works when power is applied to the SmartMotor. Therefore, it is not a
substitute for an actual brake when safety is an issue.

WARNING: The MTB feature only works when power is applied to the SmartMotor.
Therefore, DO NOT use it as a substitute for a physical brake when operator or

equipment safety is an issue.

Brake Command Examples

Example 1

Motor drive is in the ON state and not moving — it may be in Position mode and holding position, or in
Velocity mode with zero velocity (same as holding position):

 |f BRKENG is issued, the brake will engage (even if not already engaged for whatever reason) and
you then issue BRKTRJ, the brake will STAY engaged

« |If BRKRLS is issued, the brake will release (even if not already released for whatever reason),
and then you then issue BRKTRJ, the brake will engage.

Example 2

The motor is faulted due to any typical fault, such as travel limits, overcurrent, overtemp, etc. The
brake should already be mechanically engaged regardless of the mode (BRKTRJ or BRKSRV), and
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provided no manual override commands were issued since the fault occurred.

» |f BRKENG is issued, the brake will stay engaged; then issue BRKTRJ, the brake will stay
engaged.

 |f BRKRLS is issued, the brake will release (even though the motor is faulted because a manual
override command was just issued); you then issue BRKTRJ, the brake will engage because the
trajectory bit is off due to the fact that the motor is faulted.

« If the motor was in BRKTRJ and BRKSRV is issued, the brake will remain mechanically engaged.
« If the motor was in BRKSRV and BRKTRJ is issued, the brake will remain mechanically engaged.
Example 3:

If the motor is moving or holding position, and the Trajectory bit is ON, and no manual override
commands have been issued — regardless of modes BRKSRV or BRKTRJ, the brake will be mechanically
disengaged.

» |f BRKENG is issued and the motor is NOT moving, the brake will engage.

« If BRKENG is issued and the motor IS moving, the brake will engage causing the motor to
mechanically be loaded to the point of stopping and faulting out.

Example 4:

Because BRKSRYV requires 3 to 5 milliseconds to fully engage, there may be certain cases where it isn't
fast enough to hold the position, e.g., a vertical load where the user wants to put the machine to bed for
the night without any position slippage.

Use this procedure:

The program / host checks for zero motion and it knows there are no further motion commands
Then issue BRKENG

Wait for mechanical brake engage time (3 to 5 milliseconds)

Turn motor OFF

Remove power from the machine

bk wN =

EOBK(I0)

Reroute Brake Signal to I/0

NOTE: When using the EOBK and MFR commands in the same program, there is interaction that
must be considered in the code. For details, see the Programming Note in EOBK(IO) on page 445 or
MFR on page 600.

When the automated brake functions are desired for an external brake, this command can be used to
choose a specified I/0 port. This corresponds to the same /O pin numbering used by other 1/0
commands. These commands re-route the internal brake signal to the respective I/O pins. The brake
signal is active high to engage the brake to the shaft on the pulled-up 5 Volt I/0. On the 24 Volt I/0, the
default state is off (0 Volts), so the brake engages the shaft when the 24 Volt signal is low. The EOBK(-
1) command removes the brake function from any external I/O. Only one pin can be used as the brake
pin at any one time. Therefore, each command supersedes the other.

For the M-style SmartMotor, only output 8 works for that motor. Therefore, the values are:

« EOBK(8) to enable
« EOBK(-1) to disable
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Part 1: Programming: MTB

MTB

Mode Torque Brake

Mode Torque Brake is the default state on power-up. It causes the motor control circuits to tie the
three phases of the motor together as a form of dynamic braking. For a fault or the OFF command,
instead of the motor coasting to a stop, it abruptly stops. This is not done by servoing the motor to a
stop, but by simply shorting all of the coils to ground. If there is a constant torque on the motor, it
allows only very slow movement of the shaft.

WARNING: The MTB feature only works when power is applied to the SmartMotor.
Therefore, DO NOT use it as a substitute for a physical brake when operator or

equipment safety is an issue.

The MTB command immediately activates dynamic braking independently of the Brake mode. Issuing
MTB while the motor is running turns off the motor drive and enables dynamic braking, even if BRKRLS
has been issued.

To remove the effect of the MTB command, either issue a motion command, or manually "freewheel"
the motor by issuing a BRKRLS command and then an OFF command. Those two commands do not need
to be in immediate sequence—i.e., other commands, except MTB, can be between them.

BRKENG can engage dynamic braking unconditionally, as well. (The opposite of that command is
BRKRLS.) Note that OFF will not remove the effect of BRKENG.

To ensure that the MTB command is not active, command BRKRLS and the dynamic braking will release.
Finally, because faults can also activate dynamic braking, clear the faults or choose a fault action of
freewheel (refer to the next NOTE).

NOTE: The FSA command's default cause/action enables MTB on all faults, even if previously
disabled as described in the previous paragraphs. Therefore, to prevent that action, you must issue
FSA(cause,action), where "cause" is the fault type 0, 1 or 2, and the "action" is 1, which specifies
servo off (freewheel). For more details, see FSA(cause,action) on page 465.

Status Word 6, Bit 11 reports if dynamic braking is active or not, including as a result of the MTB
command, the BRKENG command or a fault action.

Index Capture Commands

The SmartMotor's encoder capture mechanism has many capabilities. Both the internal and external
encoders can be triggered by certain events to capture their positions.

The DS2020 Combitronic system also provides index capture capability; for details, see D52020
Combitronic System Index Capture on page 131.

For a capture to occur, one of the arming commands must be issued (see the next list). These
commands allow you to select a rising or falling edge of the source event and specify the encoder to be
armed.

Ai(arg) Arm the rising edge only; encoder selected by arg
Aj(arg) Arm the falling edge only; encoder selected by arg

Aij(arg) Arm the rising edge, wait for that event, then arm the falling edge; encoder
selected by arg

Aji(arg) Arm the falling edge, wait for that event, then arm the rising edge; encoder
selected by arg
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Arg is 0 to arm the event currently assigned to the internal encoder; arg is 1 to arm the event currently
assigned to the external encoder.

Status Word 1 contains bits (Bi, B}, etc.) that indicate when a particular arming sequence is active and
when the capture has taken place. For details, see Motor Index/Capture Directly-Addressed Status Bits
on page 216. Also, see Status Word 1: Index Registration and Software Travel Limits on page 922.

After the capture has occurred, the corresponding rising or falling edge can be read using the
commands I(arg) and J(arg), respectively. That allows the rising and falling edges to be recorded
separately. Again, arg is O for the internal encoder’s position at the time of the event; arg is 1 for the
external encoder’s position at the time of the event.

| reads encoder position
\ Arm with Aj*

Biflag set
Arm with A “Or, use Aij to Bj flag set
arm both

Jreads encoder position

Rising and Falling Edge Index Capture

By default, the internal encoder will be triggered by the internal encoder’s index mark. However, it can
be reconfigured to use an external signal to trigger the internal encoder capture. Refer to the next
commands.

EIRE (Default) Use the internal encoder’s index to capture that encoder's position.
The 1/0 signal is used to capture the external encoder.

EIRI Use a predefined /0 signal to capture the internal encoder. This displaces
that /O from being used to capture the external encoder. Class 5 D-style
motors use /0 logical input 6 (pin 7 on the DA-15 connector); Class 5 M-style
motors use /0 logical input 5 (pin 4 of the 12-pin I/O connector). Class 6
D-style motors use I/0 logical input 5 (pin 6 of the HD26-pin connector).

DS2020 Combitronic System Index Capture

DS2020 with resolver motors: Reading position value and physical position

In resolver motors, the physical angular position always corresponds to the read position on a single
turn. This is different from SmartMotors with incremental encoder — its "absolute" position is unknown
until the index impulse (i.e., the zero mark on the encoder) is found. This means that a DS2020
Combitronic system with resolver motor behaves in this manner:

e Assume feed FD=65536;

At the startup, a position value in the range [-32768 32767] is always returned by RPA, and this
corresponds to the physical angle of the motor shaft, read by resolver;
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Part 1: Programming: Other Motion Commands

o For example, RPA 16384 (that is % of feed) means that shaft angle is 90° with respect to the
zero position; this is always true, even if the system is restarted with a different initial position
of the shaft;

« |f many complete turns have been done (position is outside the range [-32768 32767]), when the
system is restarted, the read position will be reported in the range [-32768 32767] and its value
corresponds to the angular position of the shaft.

DS2020 with resolver motors: Index Capture function

The index capture procedure uses the commands Ai(0), RBi(0) and RI(0). When the procedure is started
with Ai(0), the closest position that corresponds to a zero-angle of motor shaft is captured. RBi(0)
initially returns O (meaning the procedure has not completed). After the zero-angle position is reached,
it is sampled: RBi(0) returns 1 and RI(0) returns the corresponding value. RBi(0) remains 1 until a new Ai
(0) command is issued (this resets RBi(0) to O and restarts the procedure). Here are some examples:

1. Assume FD=8000, initial position RPA 1000, Ai(0) command issued and motor moved in the
negative direction; when zero-angle is reached, RBi(0) returns 1 and RI(0) returns O.

2. Assume FD=8000, initial position RPA 1000, Ai(0) command issued and motor moved in the
positive direction; when zero-angle is reached, RBi(0) returns 1 and RI(0) returns 8000.

3. Assume FD=8000, initial position RPA 9000, Ai(0) command issued and motor moved in the
positive direction; when zero-angle is reached, RBi(0) returns 1 and RI(0) returns 16000.

Other Motion Commands

These commands are used to start, stop or decelerate motion, reset or shift the origin, and turn the
motor servo off. For more details on these commands, see Part 2: SmartMotor Command Reference on
page 247.

G

Go, Start Motion

The G command does more than just start motion. It can be used dynamically during motion to create
elaborate profiles. Because the SmartMotor allows position, velocity and acceleration to change during
motion, the G command can be used to replace the current move with a new one. All faults must be
cleared before the G command will work, as indicated by the "drive ready" status bit. Faults can be
cleared by correcting the fault situation and then issuing the ZS command.

S

Abruptly Stop Motion in Progress

If the S command is issued while a move is in progress, it causes an immediate and abrupt stop with all
the force the motor has to offer. After the stop, assuming there is no position error, the motor will still
be servoing. The S command works in all modes.

X

Decelerate to Stop

If the X command is issued while a move is in progress, it causes the motor to decelerate to a stop at
the last entered deceleration value according to the ADT, DT and AT commands. When the motor comes
to rest, it will servo in place until commanded to move again. The X command works in Position,
Velocity and Torque modes. It also applies to Follow and Cam modes.
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O=formula

Set/Reset Origin to Any Position

The O= command (using the letter O, not the number zero) allows the host or program to declare the
current position to a specific value, positive or negative, or 0 in the range -2147483648 to
+2147483647. This command sets the commanded trajectory position to the value specified at that
point in time and the actual position is adjusted similarly. The O= command directly changes the motor’s
position register and can be used as a tool to avoid #31-bit rollover Position mode problems. If the
SmartMotor runs in one direction for a very long time, it will reach position -2147483648 or
+2147483647, which causes the position counter to change sign. While that is not an issue with
Velocity mode, it can create problems in absolute position moves or create confusing results when
reading position.

OSH=formula

Shift the Origin by Any Distance

The OSH= command shifts the origin by the amount described, which may be from -2147483648 to
+2147483647. This command is similar to O=, except that it specifies a relative shift. This can be
useful in applications where the origin needs to be shifted during motion without losing any position
counts.

OFF

Turn Motor Servo Off

The OFF command turns off the motor’s drive. When the drive is turned off, the PWR/SERVO status
LEDs revert to flashing green. The motor will not freewheel by default in the OFF state because each
SmartMotor has a safety feature that engages dynamic braking equivalent to the MTB command. This
has the effect of causing a resistance to motion. To make a SmartMotor truly freewheel when off, issue
BRKRLS and be sure any faults are cleared.

SCALEA(m,d), SCALEP(m,d), SCALEV(m,d)

Scale (Acceleration/Deceleration, Position, Velocity)

The SCALE commands are used to scale the values of various acceleration/deceleration, position and
velocity commands, and related reporting commands. This is done by issuing SCALEA, SCALEP and
SCALEV, respectively. For example, SCALEA affects the ADT command; issuing SCALEA(10,1) applies a
factor of 10x to any set, or 1/10x to any reported, acceleration/deceleration. Once set, the

SCALE commands are in effect for all subsequent applicable commands until they are deactivated (all
three commands are deactivated by default).

For more details, see SCALEA(m,d) on page 724, SCALEP(m,d) on page 726, and SCALEV(m,d) on page
728. For the list of SCALE-affected commands, see Commands Affected by SCALE on page 903. Also,
see the Motor Scaling tool in the SMI software help.
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Part 1: Programming: Commutation Modes

Commutation Modes

Because the SmartMotor uses a brushless motor, it does not have the mechanical commutator that a
brushed motor has to switch the current to the next optimal coil as the rotor swings around. To cause
shaft rotation in a brushless motor, the control electronics have to see where the shaft is, and then
decide which coils to deliver the current to next.

The most typical way to determine the orientation of the rotor is with small magnetic-sensing devices
called Hall sensors. The process of shifting the current to the proper coils based on shaft rotation is
called commutation. There are many methods for commutating a motor; the best commutation method
depends on the application. As a general rule, sine mode commutation provides very smooth low torque
ripple performance, and trapezoidal commutation provides the highest torque and fastest speeds.

These commands allow selection of different commutation modes. For more details, see Part 2:
SmartMotor Command Reference on page 247.

NOTE: MDE, MDS and MDC require angle match (the first sighting of the encoder index) before they
will take effect. This means the SmartMotor's factory calibration is valid and the index mark of the
internal encoder has been seen since startup. Until then, the SmartMotor will operate in default
MDT.

MDT
Mode Drive Trapezoidal

Trapezoidal commutation uses only the Hall sensors (default). It is the most simple commutation
method, and it is always ready on boot up. MDT is effective despite the minor inaccuracies typically
found in the mechanical placement of the sensors.

NOTE: M-style motors boot up in MDC mode (see MDC on page 135).

MDE
Mode Drive Enhanced

This driving method is exactly the same as basic trapezoidal commutation using Hall sensors, except
that it also uses the internal encoder to add accuracy to the commutation trigger points. This idealized
trapezoidal commutation mode offers the greatest motor torque and speed, but it can exhibit minor
ticking sounds at low rates because the current shifts abruptly from one coil to the next. Because MDE
uses the encoder, it requires angle match (the first sighting of the encoder index) before it will engage.

MDS
Mode Drive Sine

This is sinusoidal (sine) commutation, voltage mode. It provides smoother commutation compared to
trapezoidal modes by shifting current gradually from one coil to the next. Because MDS uses the
encoder, for motors with incremental encoders, it requires angle match (the first sighting of the
encoder index) before it will engage. MDS is not as efficient as a trap commutation mode and has less
torque available, especially at higher speeds (for more details, see MDS on page 574). However, for
applications that require extremely smooth and quiet low-speed operation, MDS is the best choice.
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MDC

Mode Drive Current

Available only for M-style Class 5 SmartMotors, this sinusoidal (sine) commutation method, augmented
with digital current control, offers the best possible performance without sacrificing quiet operation.

Status Word 6 contains bits that indicate what commutation mode is currently active. Note that a
command for a mode may not take effect until the angle match is indicated by bit 8 in status word 6.
The angle match may not take effect until the motor rotates past the index mark of the internal
encoder. Test for this using these status bits.

Status Word 6:
» Bit 0 Trap-Hall mode
« Bit 1 Trap-Encoder (enhanced) mode
» Bit 2 Sine Voltage mode

o Bit 3 Sine Current (vector) mode

MDB

Trajectory Overshoot Braking (TOB) Option

This command should be used after entering MDT or MDE to enable TOB action. This option reverts to
off when one of the previous commutation choices is made. This option is off by default. Status Word
6, Bit 9 indicates if this mode is active.

MINV(0), MINV(1)
Invert Motion Direction
The MINV(1) command inverts the direction convention of the SmartMotor.

The MINV(0) command restores the default.
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Part 1: Programming: Modes of Operation

Modes of Operation

SmartMotors can be operated in several different modes. You can switch to and from almost any mode
freely at any time. The next sections provide details on each operation mode.

NOTE: For details on any command, see Part 2: SmartMotor Command Reference on page 247.
Torque Mode

NOTE: Torque mode is an immediate response mode.

In Torque mode, also referred to as Mode Torque (MT), the SmartMotor shaft applies a torque
independent of position. The internal encoder tracking still takes place, and can be read by a host or in
a program. However, the value is ignored for motion because the PID loop is inactive. A torque-mode
move does not mean the motor applies a constant torque regardless of speed; rather, the motor is
powered at a fixed duty cycle of PWM to the motor windings in a manner similar to increasing and
decreasing voltage to a traditional DC motor. To specify the value of the torque move, use the T=
command with a number between -32767 and 32767. Remember that:

» Positive numbers apply a clockwise torque
» Negative numbers apply a counter-clockwise torque
e The default value for T is zero
» Speed is proportional to counter-torque or load on the shaft when in torque mode
» The larger the load, the slower the motor turns for a given torque value
The next list details the minimum requirements for a move to occur in Torque mode:

e [nitiate the mode with the MT command
e Issue G
Torque Mode Example

The next example shows a basic torque move. Note that T is set before MT and G, which provides a
known commanded torque before issuing an MT or G command.

T=2000 ' set torque to 2000
MT ' set motor to Torque mode
G ' start moving, open loop

Dynamically Change from Velocity Mode to Torque Mode

The next example dynamically changes from Velocity mode to Torque mode through torque transfer
(TRQ command). In the example, about two seconds after going into Velocity mode, the motor is
switched to Torque mode. Then, two seconds later, the motor is turned off.
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MV ' set motor to Velocity mode
VT=100000 ' set velocity to 100000
ADT=1000 ' set accel/decel to 1000
G ' Go (Start moving)
WAIT=2000 ' wait about 2 seconds
T=TRQ ' set torque to the value the PID filter was commanding in MV
MT G ' set motor to Torque mode
O
WAIT=2000 ' wait about 2 seconds =
OFF ' turn the motor off =
5
Velocity Mode =
o
Velocity mode allows the SmartMotor to run at a constant commanded speed. SmartMotors close the a
speed loop on position, not encoder counts per unit time. As a result, moving to and from Position mode —
to Velocity mode is simple. i
©
The next list details the minimum requirements for a move to occur in Velocity mode: -
* Initiate Velocity mode MV command if not already in Velocity mode
* Nonzero value of Velocity VT=#H## set velocity equal to ###
* Nonzero value of Acceleration ADT=### set accel/decel equal to ###
* Go command to initiate move G start move immediately

Constant Velocity Example

The next example shows a basic constant-velocity move. In the example, the motor starts moving when
the G command is issued. It accelerates up to a velocity of 100000 at a rate or 1000 samples/sec/sec.
It then remains at that speed until told to do otherwise.

MV ' set motor to Velocity mode
VT=100000 ' set velocity to 100000
ADT=1000 ' set accel/decel to 1000

G ' Go (Start moving)

Change Commanded Speed and Acceleration

In this example, the command speed and acceleration are changed while the program is in progress. The
motor's move parameters are changed about two seconds after the initial commanded move begins.

0=0 ' set current position to zero

MV ' set motor to Velocity mode

VT=100000 ' set velocity to 100000

ADT=1000 ' set accel/decel to 1000

G ' Go (Start moving)

WAIT=2000 ' wait 2 seconds

VT=800000 ' set new velocity of 800000

ADT=500 ' set new accel/decel of 500

G ' initiate change in speed and acceleration
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Part 1: Programming: Absolute (Position) Mode

Absolute (Position) Mode

Absolute (Position) mode is the default power-up mode of operation for the SmartMotor. In Position
mode, the SmartMotor operates on absolute position commands, which use encoder counts.

The next list details the minimum requirements for a move to occur in Position mode:

* Initiate Position mode MP command if not already in Position mode
* Nonzero value of Velocity VT=### set velocity equal to ###

* Nonzero value of Acceleration ADT=### set accel/decel equal to ###

* Absolute commanded position PT=### set target position to ###

* Go command to initiate move G start move immediately

NOTE: Commanded position must be different than present position to cause a move. If acceleration
or velocity are at zero, the motor will not move.

Absolute Move Example

In this example, the motor starts moving when the G (Go) command is received and stops at an absolute
position of 20000 encoder counts.

MP ' set to position mode (required if currently in another mode)
VT=100000 ' set velocity to 100000

ADT=1000 ' set accel/decel to 1000

PT=20000 ' set commanded absolute position to 20000

G ' Go (Start moving)

Two Moves with Delay Example

The next example shows two position moves with a delay in between.

0=0 ' set current position to zero

MP ' set to position mode (required if currently in another mode)
VT=100000 ' set velocity to 100000

ADT=1000 ' set accel/decel to 1000

PT=20000 ' set commanded absolute position to 20000

G ' Go (Start moving)

TWAIT ' wait here until the motor has reached 20000

WAIT=1000 ' wait 1 second

PT=-500 ' Set commanded position of -500

G ' start moving to new commanded position.

NOTE: The move is made at the previously-commanded speed and acceleration.
Change Speed and Acceleration Example

In this example, the commanded speed and acceleration are changed while the motor is executing the
absolute position move.
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0=0 ' set current position to zero

MP ' set to position mode (required if currently in another mode)

VT=100000 ' set velocity to 100000

ADT=1000 ' set accel/decel to 1000

PT=1000000 ' set commanded absolute position to 1000000

G ' Go (Start moving)

WAIT=8000 ' wait about 8 seconds

VT=800000 ' set new velocity of 800000

ADT=500 ' set new accel/decel of 500 _é

G ' initiate change in speed and acceleration =
e

Shift Point of Origin Example B0
o

The next example demonstrates how to change (shift) the point of origin between moves. This is d_

accomplished through the OSH command. The Origin command O={value} may also be used and can be —

set to any absolute number. %

0=0 ' set current position to zero o

MP ' set to position mode (required if currently in another mode)

VT=100000 ' set velocity to 100000

ADT=1000 ' set accel/decel to 1000

PT=2000 ' set commanded absolute position to 2000

G ' Go (Start moving)

TWAIT ' wait until move is complete

OSH=-2000 ' shift current position back 2000 counts

WAIT=8000 ' wait 8 seconds

PT=2000 ' set commanded absolute position to 2000

G ' Go (Start moving)

TWAIT ' wait until move is complete

NOTE: The motor moved a total of 4000 counts, but its current position is only 2000 because it was
reset to zero between moves.

Relative Position Mode

In Relative Position mode the SmartMotor moves relative to its current position by the use of the PRT
(Position Relative Target) command.

The next list details the minimum requirements for a move to occur in Relative mode:

* Initiate Position mode MP command if not already in Position mode
* Nonzero value of Velocity VT=### set velocity equal to ###

* Nonzero value of Acceleration ADT=### set accel/decel equal to ###

* Relative commanded position PRT=### set relative position to ###

* Go command to initiate move G start move immediately

Relative Mode Example

The next example illustrates the use of Relative mode. The example moves the motor through three
2000-count moves or a total of 6000 counts.
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Part 1: Programming: Follow Mode with Ratio (Electronic Gearing)

MP ' set to position mode (required if currently in another mode)
VT=100000 ' set velocity to 100000

ADT=1000 ' set accel/decel to 1000

PRT=2000 ' set commanded relative position move to 2000

G ' Go (Start moving 2000 counts)

TWAIT ' wait until move is complete

G ' Go (move 2000 counts again)

TWAIT ' wait until move is complete

G ' Go (One more time)

Follow Mode with Ratio (Electronic Gearing)

Follow Mode with Ratio (MFR) allows a motor to follow a standard TTL quadrature external encoder
input signal, or internal clock, at a user-defined ratio.

By default, Follow mode runs continuously at a ratio of 1:1 in terms of input counts to distance moved.

The user can freely select either the external encoder or fixed rate internal clock as the input source.
The fixed rate internal clock runs at 8000 counts per second by default, but can be influenced by the
PID commands. The SRC command defines whether to follow the internal counter or external encoder.

NOTE: Changed MFR values do not take effect until after the next G command.

The next list details the minimum requirements for a move to occur in Follow mode:

* Set Incoming counts multiplier MFMUL=### may be negative or positive
* Set Incoming counts divisor MFDIV=### may be negative or positive
» Calculate above ratio and mode MFR

* Go command to initiate the move G start following the encoder

NOTE: If the external encoder is not moving, no motion will occur. Commanded position must be
different than present position to cause a move.

CAUTION: Do not switch between gear modes while in operation. When a
transition is made, the profile must be stopped or the motor must be turned off.

Electronic Gearing and Camming over CANopen

Beginning with firmware 5.x.4.30 and later, the SmartMotor provides precise time synchronization over
CANopen between motors for electronic gearing and camming applications (for example, traverse and
take-up spooling). The CANopen objects related to this are: 1005h, 1006h, 2207h, 2208h, 2209h,
220Ah-220Dh. For details on these objects refer to the SmartMotor CANopen Guide. For a sample user
program, see CAN Bus - Time Sync Follow Encoder on page 883.

NOTE: This capability is currently available on Class 5 SmartMotors only.
Electronic Gearing Commands

The next sections describe related commands. For more details on these commands, see Part 2:
SmartMotor Command Reference on page 247.
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SRC(enc src)

Select the input source used in Follow and Cam modes
The SRC() command can allow the SmartMotor to use the many advanced following and camming
functions even without an external encoder input. Values for enc _src:

0 Null (pauses controller)
1 External encoder (-1 inverts direction)

2 Time-base at PID rate (-2 inverts direction)
NOTE: SRC() can be updated while the motor is running. However, sudden speed changes may occur.
MFR

NOTE: When using the EOBK and MFR commands in the same program, there is interaction that
must be considered in the code. For details, see the Programming Note in EOBK(IO) on page 445 or
MFR on page 600.

Configure A & B inputs to Quadrature mode and select Follow mode

The Mode Follow Ratio (MFR) command configures the A and B inputs of the motor to be read as
standard quadrature inputs and puts the SmartMotor in Follow mode.

For a figure showing use examples of this command, see MFSDC Modes on page 148.

MSR

Configure A & B inputs to Step/Direction mode and select Follow mode

The Mode Step Ratio (MSR) command configures the A and B inputs of the motor to be read as
standard Step and Direction inputs and puts the SmartMotor in Follow mode.

MFO
Reset external quadrature encoder
MSo0

Exit Step/Direction Follow mode

When using the ENC1 command, be careful that you do not inadvertently change the operation of the
encoder with the MFO or MS0 command. If you must use an alternate encoder source for Follow mode
and at the same time use ENC1, then choose the version of the above commands to match your
encoder type for the ENC1 command.

MFMUL=formula, MFDIV=formula

Set Follow mode ratio

The internal mathematics work best by describing the Follow mode ratio in terms of a fraction of two
integers. Choose MFMUL and MFDIV to create the Follow mode ratio if it is not 1:1 (the default). Any
change to the ratio will be enabled by the G command.

MFMUL=formula 'Multiplier applied to Follow mode ratio
MEFDIV=formula 'Divisor applied to Follow mode ratio
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Part 1: Programming: MFA(distance[,m/s])

MFA(distance[,m/s])
Ascend ramp to sync. ratio from ratio of 0

distance  Setting from 0 to 2147483647. Set to O to disable. By default, it is disabled.

[m/s] Is optional and specifies the meaning of distance. Values of [m/s]: O for des-
ignating input units (controller units) and 1 for designating distance traveled (fol-
'E lower units).
=
© For a figure showing use examples of this command, see MFSDC Modes on page 148.

o0

DE_ MFD(distance[,m/s])

; Descend ramp from ratio to ratio of 0

(o]

0 distance Setting from 0 to 2147483647. Set to 0 (default) to disable.

[m/s] Is optional and specifies the meaning of distance. Values of [m/s]: O for des-

ignating input units (controller units) and 1 for designating distance traveled (fol-
lower units).

For a figure showing use examples of this command, see MFSDC Modes on page 148.
MFSLEW(distance[,m/s])
Slew at ratio for a fixed distance

distance Setting from -1 to 2147483647. Set to -1 (default) to disable. When disabled,
Follow mode runs at ratio continuously.

[m/s] Is optional and specifies the meaning of distance. Values of [m/s]: O for des-
ignating input units (controller units) and 1 for designating distance traveled (fol-
lower units).

For a figure showing use examples of this command, see MFSDC Modes on page 148.

CAUTION: The next gearing examples are relative to the motor shaft position at
the time the G command is issued.

All distances are relative.

Follow Internal Clock Source Example

In this example, the motor follows the internal source at a 1:1 ratio and moves at a rate of 8000 counts
per second. For a NEMA 23 frame motor, that results in 2 RPS or 120 RPM motion.

NOTE: The trajectory and drive status LEDs will be continuously green. This is because the motor is
constantly calculating a trajectory from the gearing source signal.

SRC(-2) Results in inverting controller signal direction and changing motor direction.
Changing the sign of either MFMUL or MFDIV also inverts direction.

SRC(-1) Inverts the external encoder signal; provides the easiest way to correct for
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inverted encoder signal direction.
SRC(0)  Null (pauses controller counts).

SRC(1)  (Default) Sets motor to follow the external encoder.

SRC(2)  Use one count per PID cycle (default is 8.0 kHz).

CAUTION: MFMUL must not be set excessively higher than MFDIV. Doing so will =

A result in small changes in controller counts and large changes in follower-gearing E

counts. This may cause motor harmonic distortion or following errors. ©

2

SRC (2) 'Set signal source to internal 8K counts/sec i

MEMUL=100 'Default is 1 —

MFDIV=100 'Default is 1 ©

MFR 'Enable Follow mode at specified ratio o
G

Follow Incoming Encoder Signal With Ramps Example

This example shows a profile driven by an incoming encoder signal. In addition to following the incoming
encoder, the SmartMotor performs an acceleration (ascend or ramp up) into the following relationship
(slew), and after a prescribed distance, performs a deceleration (descend or ramp down) back to rest.
Refer to the next figures.
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Part 1: Programming: Follow Incoming Encoder Signal With Ramps Example

Trapezoidal Move Profile (TMP): MFMUL=300, MFDIV=100
35
<t Ramp ;:
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Trapezoidal Move Profile (TMP) and Output Position Diagrams

In the first graph, the 'controller' (encoder source counts into TMP) is along the horizontal axis of the
graph, and the gear ratio (MFMUL/MFDIV) is along the vertical axis of the graph. This demonstrates
that "area under the curve" is the 'follower' position.

The second graphs shows the follower position as a function of controller encoder source counts to
intermediate counts (the TMP output). In this example, MFA, MFD and MFSLEW are commanded in
controller units (source counts). These three commands can accept either controller (source counts) or
follower units (intermediate counts) according to the second argument as a 0 or 1, respectively. The
firmware automatically calculates the move accordingly. The next example uses the command(x,0) form
to specify 'controller' or source counts.

MEMUL=300

MEDIV=100

MFA (200, 0) 'Move 200 controller counts over ascend (area "A")

MED (400, 0) 'Move 400 controller counts over descend (area "D")
MESLEW (200, 0) 'Maintain sync ratio for 200 controller counts (area "S")
MFR 'Enable Follow mode at specified ratio

G

Each time a G (Go) is received, the motor follows the Trapezoidal Move Profile (TMP).
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For labeling applications, it may be beneficial to feed out over a preset distance profile, also known as
a "one-shot" gearing trapezoidal profile. This is where the MFSLEW() command comes in, as shown in
the code and figures.

Each parameter distance is subject to follower counts, not controller counts.

The total distance traveled by the follower will be MFA distance + MFD distance + MFSLEW distance.
In this case, 300+600+600 or 1500 total follower counts moved.

Electronic Line Shaft

NOTE: This section only applies to M-style motors.

grammin

For some applications, it is useful to create a controller/follower motor relationship known as an
"electronic line shaft" (see the next figure). This setup is used for machines such as printing presses,
where everything must run at proportional speeds to the main (controller) axis.
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Encoder

Electronic Line Shaft Diagram

On the M-style SmartMotors, there is a bidirectional Encoder Bus port. Using this port, along with
Moog Animatics encoder bus cables, you can daisy chain a series of M-style motors:

o One motor will have ENCD(1) issued; this will be the controller.

o All other motors will have ENCD(0) (default) issued; these will be the follower devices.

ENCD(in out)

Sets the Encoder Bus port as an input or an output — only applies to motors with Encoder Bus
connecters, such as M-style SmartMotors.

The ENCD() command allows the M-style SmartMotor to use the Encoder Bus port as either an input or
an output. This allows the motor to operate as a controller (output) or follower (input) when daisy
chained to other M-series motors through the Encoder Bus ports. The value for

in_out can be hard-coded or a variable:

0  (Default) Encoder Bus port is an input.

1 Encoder Bus port is an output.
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Part 1: Programming: Spooling and Winding Overview

The ENCD() command can be used over the Combitronic network.
Spooling and Winding Overview

Spooling or winding provides a cost-effective way to package materials of very long length, such as
thread, film, labels, cable and thermoplastics. The material is fed from a large spool at a certain rate
onto another spool, with a traversing mechanism between the two spools to create the desired pattern
or evenly wind onto an flanged spool or cylindrical core despite the core shape. The integrity of the
spool is often based on precise patterns and proper tension control throughout the winding process.
The next figure provides examples of common spool-winding patterns:

SPOOL WINDING PATTERNS

Tapered Wind on Cylin-
drical Core

A taper is built on the
spoal, then the matarial is
traversed across the full
length

Level Wind

The turnaround ends of
cach layer are at the same
point

Index Wind

Frogrammed stacked lanes
with precise programmed
index to the adjacent lane
also called step wind

Taper Wind

Each traverse layers a
programmed amount from
the edge to form a partial
pyramidal shape

Virtual Flange Wind
Index wind pattern on
the ends with level wind
between ends

Reverse Taper Wind
{Inverse of taper)
Requires specially flanged
reels

There are various problems associated with winding and spooling applications, such as: material tension
control, setting proper dwell points, over/under-travel (which results in a "dog bone" shape) and tapered
patterns with low-friction materials or wound onto cylindrical cores.

The next sections provide commands and example programs designed to help you handle the challenges
of spooling/winding applications.

Relative Position, Auto-Traverse Spool Winding

The next figure provides a simple representation of an auto-traversing spool winding application.
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Part 1: Programming: MFSDC(distance,mode)

Encoder
Signal
Spool winder
[controller)

Traverse motor
(follower)

supply reel

Auto-Traversing Spool Winding Mechanism

The MFSDC command is used to initiate the dwell and reverse direction (traverse) needed to perform
spooling/winding operations.

MFSDC(C(distance,mode)

Dwell at 0O ratio for input distance

distance Set from 0 to 2147483647 through a variable or hard-coded value to specify
the number of controller counts the follower dwells at zero ratio. Set to -1
(default) to disable (see the first row of the next table). When disabled, Follow
mode runs at ratio continuously.
mode Specifies the gearing profile application in firmware, as shown in the next table.
These follow a predefined trapezoidal profile (see the next figure).
For example, a setting of O for mode is typical for feeding labels in label
applications; a setting of 1 is typical for traverse-and-takeup spool winding
applications.
dist | mode | Motion Repeat Run state; Initiated by
-1 0| relative one cycle, no repeat once; a G or G(2) command
X 0| relative repeat, one direction continuous; after initial G or G(2)
X 1| relative traverse back/forth continuous; after initial G or G(2)
X 2| absolute traverse back/forth continuous; after initial G or G(2)

CAUTION: Any value other than -1 for the MFSDC distance command causes the
motion profile to continuously dwell and repeat. Reissue the command with
distance equal to -1 to stop the repetitive motion.

NOTE: The MFMUL and MFDIV commands do not have an effect on dwell time or distance. Dwell is
strictly based on raw controller encoder counts selected by the SRC() command specifying internal
virtual or external controller count source.
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Part 1: Programming: MFSDC(distance,mode)

MFSDC(-1,0) one cycle (no repeat)
MFSLEW

MFA slew MFD

ascend descend

-

Gissued

MFSDC(x,0) x=dwell distance; motor repeats in one direction

= MFSLEW Can be used

= slew with Camming
£ MFA MFD operation

© ascend descend MFSDC

00 N dwell  \_

Gissued (just once) No G required

MFSDC(x,1) x=dwell distance; motor traverses
MFSLEW

(@)
.
o
\;i
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MFA

MFD
MFSDC No G required

dwell

ascend descend

A\ Gissued (just once)

MFSDC(x,2) x=dwell distance; motor traverses between abs. values of MFHTP & MFLTP

DO NOT USE
No G required with Cammin
MFSDC_ ("~ a i 9
MFHTP MFHTP MFLTP operation
I\ dwell

Gissued (just once)

NOTE: The examples above work when MFSLEW(x,y) has been set. By default, x is -1, which means “slew forever”
and prevents the repeating cycles shown above. Therefore, to disable any of these modes and go back to forev-
er-run at slew, set MFSLEW(-1,0); to get one of the cycles above, ensure that MFSLEW(x,y) where x >= 0.

Xissued
No MFSDC command , or no MFD with OFF
MFSLEW ~ Xissued MFSLEW "~ for abrupt Stop
MFA>g/  slew foreverunless MFD>0 MFA=0 | s, SiWforeverunless o JMFD=0
MFR ascend descend MFR change change
~ Gissued ~ Gissued
MFSDC Modes

The next example demonstrates the use of the MFSDC command. It is a spool-winding program that
performs a following profile across the spool, a dwell at the end for a specific span of input distance
and then reverses the profile back to the original end of the spool for another dwell. The motion
repeats until another MFSDC command is issued with Expl equal to -1 and then a G command, or an X
or S command, is issued.
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Part 1: Programming: Dedicated, Absolute Position, Winding Traverse Commands

grammin

a=1000 'Ascend and descend distance in follower counts
b=200000 'Spool width in follower counts

c=4000 'One rev of spool in controller counts

s=b-(a*2) 'Calculate MFSLEW distance

m=1000 'Gear ratio multiplier

d=1000 'Gear ratio divisor

MFMUL=m 'Set ratios for gearing

MEDIV=d

MFA (a, 1) 'Set ascend into ratio distance

MED (a, 1) 'Set descend out of ratio distance

MFSLEW (s, 1) 'Set slew dis. between the accel and decel points
MFSDC (c, 1) 'Set dwell for "c" counts, auto rev. after dwell
MFR 'Enable Follow mode at specified ratio

G 'Start following the external controller encoder

NOTE: The G command assumes the cycle starts at the same end of the spool each time.

A shift back and forth to the oscillation can be achieved by running in dual-trajectory mode. For more
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information on dual-trajectory mode, see Dual Trajectories on page 175.

SRC (2) 'Set signal source to internal 8K counts/sec

MEMUL=100 'Default is 1

MEDIV=100 'Default is 1

MFA (500,1) 'Set ascend ratio distance of 500 follower counts

MED (500, 1) 'Set descend ratio distance of 500 follower counts

MFR (2) 'Enable Follow mode for SECOND TRAJECTORY at specified ratio

MESLEW (8000, 1)
MESDC (100, 1)

'Stay at slew ratio for 8000 counts of the follower
'Dwell for 100 counts, auto repeat in reverse direction

G(2) 'Begin to follow controller signal in SECOND trajectory
MP (1) 'Set FIRST TRAJECTORY mode to Position mode

VT=100000 'Set velocity to run over top of gearing

ADT=100 'Set accel/decel to run over gearing

PRT=1000 'Set relative move

G(1) 'Shift all motion 1000 counts in positive direction

CAUTION: In the above example, repeating G(1) continuously shifts oscillation in
the positive direction by 1000 counts or the value in PRT.

NOTE: A velocity MV(1) or position MP(1) mode may be used over gearing. All distances are relative
to gearing. The command X(2) stops gearing; the command X(1) stops position or velocity moves.

Dedicated, Absolute Position, Winding Traverse Commands

This section applies to absolute positioning in electronic gearing. It is specifically tailored to traverse
and take-up winders.

Refer to the next figure. The MFMUL and MFDIV commands, which were previously described in this
chapter, are used to set the ratio of controller to follower motion as a maximum when slew is reached.
The sign of MEMUL/MFDIV is ignored in this mode of operation — only the absolute value is used. The
initial direction of motion is not affected by the sign of MFMUL/MFDIV.

NOTE: If MFMUL=0, then the traverse process will end when the next endpoint is reached.
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Part 1: Programming: MFSDC(distance,2)

I =T R TR T T =t

Refer to the next figure. The MFSDC command enables the absolute traverse mode of operation. The
MFLTP and MFHTP commands are then used to set the low and high traverse points, respectively,
which control the spool width and position.

NOTE: The value of MFHTP must be greater than or equal to the value of MFLTP.
MFHTP  MFLTP MFHTP MFLTP MFHTP MFLTP

—"mlml@i—_ o ﬂmmn%{[/{r o ﬁnumnmnuwﬂﬂlﬂi-_ T

The next sections describe related commands. For more details on these commands, see Part 2:
SmartMotor Command Reference on page 247. They are not intended to be combined with Cam mode.

MFSDC(C(distance,2)

Absolute traverse mode for input distance

distance Length of the dwell at both ends of the move in controller units. Use -1 to
disable; range of distance is 0 to 2147483647.
2 Activates the absolute traverse mode of operation.

For additional details and figures, see MFSDC(distance,mode) on page 147.

MFLTP=formula

Mode follow lower traverse point

formula Specifies the lower traverse point. Range is any 32-bit signed value. It must
be less than or equal to MFHTP; MFHTP-MFLTP must be less than 231,

For a figure showing use examples of this command, see MFSDC Modes on page 148.
MFHTP=formula

Mode follow higher traverse point

formula Specifies the higher traverse point. Range is any 32-bit signed value. It must
be greater than or equal to MFHTP; MFHTP-MFLTP must be less than 231.

For a figure showing use examples of this command, see MFSDC Modes on page 148.
MFCTP(argl,arg2)
Sets control information for traverse mode

argl Sets initial direction motor will move upon receiving G.

argl=-1: (When G is issued) Traverse toward most recent direction when
previous traverse move ended. This is most likely required in all winders.

Moog Animatics SmartMotor™ Developer's Guide, Rev. R
Page 150 of 969



Part 1: Programming: MFL(distance[,m/s])

« This direction is indicated by Status Word 7, Bit 13.
* This state is not reset by an X or an OFF.

argl=0: (Power-up default value) Initially traverse toward higher bound when G
is issued.

argl=1: Initially traverse toward lower bound when G is issued.
arg2 Special bits:

arg2=1: The RPC(2) frame of reference is updated with shaft motion when the
servo is off (OFF, MTB, MT). This is a special setting to ensure backward
compatibility with existing applications that may use the RPC(2) frame of
reference.

arg2=0: (Power-up default value) The RPC(2) frame of reference is frozen when
the servo is off (through OFF, MTB, MT).

MFL(distance[,m/s])

Ramp at the lower end of traverse; designate controller or follower

distance Specifies the ramp distance at the lower end of the traverse. Distance range:
0 to 2147483647
[m/s] O=controller, 1=follower; distance range: 0 to 2147483647

For a figure showing use examples of this command, see MFSDC Modes on page 148.
MFH(distance[,m/s])

Ramp at the higher end of traverse; designate controller or follower

distance Specifies the ramp distance at the higher end of the traverse. Distance range:
0 to 2147483647
[,[m/s] O=controller, 1=follower; distance range: 0 to 2147483647

For a figure showing use examples of this command, see MFSDC Modes on page 148.

ECS(counts)

Encoder count shift — immediately compensates for variation in material width

counts Specifies the counts to be added to (or subtracted from) incoming controller
counts as if they had an immediate change in value. For example, if the
external encoder count is 4000, and ECS(1234) is issued, the count would
immediately shift to 5234. Note that when the MFMUL:MFDIV ratio is other
than 1:1, the ratio is multiplied by the ECS value.

.ﬁ CAUTION: Large values may cause jerks in motion or following errors.

The ECS command is dynamic and immediate (not buffered), and it does not require a G command.
Further, it works on top of any gearing or camming mode.
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Part 1: Programming: Single Trajectory Example Program

Proper use of the ECS command will allow full

packing of material onto a spool regardless of I I
variance in material width. - .
i |

1. A sensor reads the material width.

2. Through programming, the user will scale
value to encoder counts. O = e :
3. Based on encoder counts, the traversing
SmartMotor will have ECS(encoder counts) h
issued, which results in a change to Material Sensor
incoming controller counts by that value. (mounted in close
| proximity to
4. The SmartMotor adjusts its gearing. I T \"‘ master spool)

The ECS command is for tiny continuous corrections, where changing MFMUL or MFDIV is not desired
because the basic ratio needs to remain fixed, but changes in demand for correction may need to be
adjusted over time. For example, assuming you have a program with normal gearing:

MFMUL=1 'Ratio (default is 1)

MEFDIV=1 'Ratio (default is 1)

MFR 'Enable Follow mode at specified ratio
G 'Begin move.

In this case, the motor begins spinning at a 1:1 ratio of external encoder input. Then you issue:

ECS(10) 'Encoder count shift of 10 counts

The motor will lunge forward by 10 encoder counts, as shown in the next figure.

Motor EC5=10D
Counts

l\‘ MFMUL=1

MFDMN=1

Master counts

Change Caused by ECS Command

However, if MFMUL=100 and MFDIV=1 (100:1 ratio), the motor would lunge forward by 1000 counts
because the ratio is multiplied by the ECS value. In this case, if EL (Error Limit) was set to 1000 or less,
the change from ECS would cause an instantaneous following error. It could also cause peak
overcurrent errors.

Single Trajectory Example Program

The next example shows a single-trajectory traverse winding application. It uses the commands for
high/low ramps and traverse points, which were discussed previously. For details, see Dedicated,
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Part 1: Programming: Chevron Wrap Example

Absolute Position, Winding Traverse Commands on page 149.

*** User does some type of homing before this. ***

SRC (2) '***% For Demo controller signal ***
'Typical applications would use SRC(1l) for encoder input.
MFCTP (0,1) 'Start traverse state in "normal" direction

'Activate update of RCP(2) when servo is off o
MFL (1000,1) 'Lower-end ramp =
MFH (1000, 1) '"Higher-end ramp £
MFLTP=-1000 'Lower traverse point %
MFHTP=1000 'Higher traverse point B0
MFMUL=1 'Ratio (default is 1) C‘LE
MFDIV=1 'Ratio (default is 1) o
MFSDC (4000, 2) 'Dwell for 4000 counts, 2 is active traverse mode —
MFR 'Enable Follow mode at specified ratio éE
G 'Begin move

Chevron Wrap Example

This example uses a more complex winding method, where camming (high-frequency oscillation) occurs
on top of gearing (low-frequency traverse), to create a custom "chevron" wrap. For electronic camming
details, see Cam Mode (Electronic Camming) on page 156.

The frequency plot for this winding method is shown in the next figure.

___Ill

"Chevron" Winding Frequency Plot
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Part 1: Programming: Chevron Wrap Example

Note that camming can be linear, or cubic spline, which permits a smooth, high-frequency oscillation on
top of the low-frequency traverse. Refer to the next figure.

A

Smooth High-Frequency Oscillation

The overlapping "chevron" wraps are advantageous because they prevent the material from becoming
trapped in the windings of the underlying layer, which can cause it to be pinched/kinked or break during
removal. Either of those conditions would cause the spool to be defective. Refer to the next figures.

2D

3D

To create this solution, the SmartMotor requires only four parameters:

'System parameters:

c=8000 'Controller (External) Encoder resolution
' (counts per 360 deg turn of spool)
w=10000 'Spool width distance in encoder counts of traversing follower motor

'Chevron shape parameters:

n=1000 'Follower counts per full (360 deg) turn of controller spool (pitch)

nn=1000 'Follower counts per half (180 deg) turn of controller spool
'(amplitude of chevron)

The complete code example is available in Chevron Traverse & Takeup on page 87/7. For more
information on electronic camming, see Cam Mode (Electronic Camming) on page 156. Also, see the
Fixed Segment Cam Simulator (available on the Moog Animatics website at
https://www.animatics.com/support/downloads.knowledgebase.html), which is a gearing/camming
training aid.
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Part 1: Programming: Other Traverse Mode Notes

Other Traverse Mode Notes

These are other notes related to operation in Traverse mode.

o MFA() is not used at this time in Traverse mode.

« MFD() should only be used for a stop from the X command while in Traverse mode.

« The traverse points are in the context of move generator 2: RPC(2). If multiple trajectories are
commanded after the start of the move, then they are not specifically in the context of the
motor shaft's actual position (RPA).

rammin

« RPC is automatically copied to RPC(2) at the start of the Traverse move only during single-
trajectory moves. This is done to accommodate the typical use of a single trajectory where the
user is homing the machine based on shaft position.

« If multiple trajectories are active, then the user is responsible for setting RPC(2) with the O(2)=
command or shifting with the OSH(2)= command to establish the desired frame of reference.

CAUTION: Do not issue a change to RPC(2) during a traverse move using either the

0(2)= or OSH(2)= command. This will produce unpredictable behavior that is
undefined at this time. Those commands should be issued before issuing a G or G
(2) when in dual-trajectory mode.
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« MFMUL and MFDIV determine the ratio of controller to follower motion as a maximum when a
slew is reached.

 The sign of MEMUL/MFDIV is irrelevant in this mode of operation. Only the absolute value
is used.

+ The initial direction of motion is not affected by the sign of MFMUL/MFDIV.
» |f MEMUL=0, then the traverse process ends when the next endpoint is reached.

» Traverse mode of operation is initiated using the G command. G may be issued from drive off or
other modes of operation.

CAUTION: Do not repeat the G command while in traverse mode. Doing so will
produce unpredictable behavior that is undefined at this time.
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Part 1: Programming: Traverse Mode Status Bits

Traverse Mode Status Bits

Status
Word Bit Description
7 8 Trajectory is in progress. Indicates that trajectory is being generated and
continuous motion is in progress, even if in a dwell state.
Bit is cleared when X, S, fault, OFF or MFMUL=0 ends the trajectory.
7 9 Ascend: In Traverse mode, this indicates the lower traverse point ramp is in
progress.
10 Slew: in Traverse mode, this indicates the slew segment is in progress.
11 Descend: In Traverse mode, this indicates the higher traverse point ramp is in
progress.
12 Dwell: In Traverse mode, this indicates the higher dwell state in progress.
13 State: The most recent Traverse mode state.
=0 Motion profile is set to/moving in the forward direction. This is the power-up
default state.
=1 Motion profile is set to/moving in the reverse direction.
The use of status word 7, bit 13 is undefined in other modes of operation with
trajectory 2.
7 14 Dwell: In Traverse mode, this indicates the lower dwell state in progress.

Cam Mode (Electronic Camming)

Electronic camming is similar to mechanical cams — for a given controller rotating device, a follower
device tracks the speed and moves through a fixed profile of positions. In electronic camming, the
profile is a look-up table of data stored in the follower motor.

CAM
Mataor
Puosition

Controller Encoder Position

Example Cam Profile

The SmartMotor supports motion profiles based on data stored in a Cam table. The Cam table can
reside in EEPROM memory or in the user array.

NOTE: Cam tables can be written to EEPROM memory, which retains its contents when power is
removed; or to the variable data space, which provides more flexibility but is cleared when power is
removed.
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Part 1: Programming: Cam Mode (Electronic Camming)

These are the available storage locations:
+ RAM storage: 1 Cam table
» 52 fixed length data points, 35 variable length data points
» Flash storage: 9 Cam tables
« 750 fixed length data points, 500 variable length data points

« EEPROM: Up to 8000 points total may be stored and moved to flash or RAM

Cam table data may be directly imported from a tab delimited text file or spreadsheet.

grammin

» Data imported to the SMI software can be written into a program, copied to the clipboard or
written directly (live) into a motor

« Import function allows for optimizing data points for cubic spline interpolation
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The motor position is interpolated between each data point. This interpolation can be specified as
linear, spline that is not periodic and spline that is periodic. Spline mode allows motion paths to be
created from a reduced number of points. For example, the next figure shows an X-Y plot of Cam
tables running on two motors. While the original data contained over 700 data points, Spline mode
reduced the data set to approximately 30 points in each motor.

O M Mekar's Dala
® v Kokor's Dala

— Path

B Foints common to X and ¥

Example of Spline Mode Points and Motion Path

Cam mode has the ability to apply sophisticated shaping and selection of the encoder input source
using Follow mode. Cam mode uses MFMUL and MFDIV to set the follow ratio for incoming controller
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Part 1: Programming: Electronic Camming Details

counts. Through the use of the SRC command, either the external encoder or a fixed-rate "virtual
encoder” can be used as the input source to the cam. This fixed-rate (virtual) encoder also works
through Follow mode, so the actual rate into the cam can be set. The speed of the virtual encoder is
equivalent to the PID rate. In other words, for a Class 5 motor at its default PID rate of 8000 Hz, the
virtual encoder sees 8000 encoder counts per second.

One example of this is a complex "chevron" pattern winding application where camming (high-frequency
oscillation) occurs on top of gearing (low-frequency traverse). This is used to spool material in a way
that prevents it from getting pinched or trapped in the underlying layers. For more details, see Chevron
Wrap Example on page 153.

Electronic Camming Details

For a brief description of the Cam mode (electronic camming) commands in this section, see Electronic
Camming Commands on page 165. Follow mode (electronic gearing) commands were previously
discussed in Electronic Gearing Commands on page 140. Also, refer to the detailed command
descriptions in Part 2: SmartMotor Command Reference on page 247.

Understanding the Inputs

There are two modes of operation (and associated commands) that involve the Trapezoidal Move
Profile (TMP):

« MFR (Mode Follow Ratio) / MSR (Mode Step Ratio): TMP function only.

MFR uses external encoder input if it is in quadrature mode; MSR uses step/direction mode.
When using SRC(2) — internal time base at PID rate — there isn't a distinction.

o MC (Mode Cam): TMP function with Cam function
The TMP function's output (intermediate counts) feeds into the cam’s input.

Motion is created by "massaging" TMP intermediate counts into the cam table. It is NOT gearing
summed with camming. If the cam length is O, there is no motion!

Use the Fixed Segment Cam Simulator (available on the Moog Animatics website at
https://www.animatics.com/support/downloads.knowledgebase.html) to learn how to properly select

the appropriate settings that perform the number of cam cycles desired. For example, you can use it to
determine the settings if the application intends to perform a single-shot of the whole cam (refer to
Camming - Demo XY Circle on page 875 for a single-shot program example).

NOTE: The Fixed Segment Cam Simulator is intended as a gearing/camming training aid only. It is
not designed as an all-inclusive means for creating camming applications.

Refer to the next figure.

Moog Animatics SmartMotor™ Developer's Guide, Rev. R
Page 158 of 969


https://www.animatics.com/support/downloads.knowledgebase.html

Part 1: Programming: Understanding the Inputs

Follow mode (MFR)

Intermediate
Encoder | Source Counts | Trap. move | Counts | Output
input / - prof. (TMP) / “| motion
MFA(x,0) MFA(x,1) MFD and MFSLEW are handled in
Source counts Intermediate counts the same manner in terms of
input to TMP output from TMP “source” and “intermediate” counts
Cam mode (MC)
Motion is created by “massaging ” TMP é
Encoder o | Trap. move «| Cam | Output Intermediate Counts into the cam table. It =
input Source Counts | prof. (TMP) | Intermediate ~ | function “| motion is NOT gearing summed with camming! ©
Counts l.e,, if cam length is O, there is no motion! —

NOTE: The relationship between TMP source counts and TMP intermediate counts is affected by the ratio of MEMUL/MFDIV.
For gearing, MFMUL/MFDIV determines how far; for camming, MFMUL/MFDIV determines how fast.

Follow Mode and Cam Mode Functional Diagrams
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NOTE: Before programming an electronic camming application, it is strongly recommended to first
evaluate your application in terms of source counts or intermediate counts, and variable or fixed
cam. Refer to the next two sections.
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Part 1: Programming: Should | choose Source Counts or Intermediate Counts?

Should | choose Source Counts or Intermediate Counts?

NOTE: In order to simplify programming and math calculations, it is strongly recommended that all
MFA, MFSLEW and MFD second parameters be the same, either a O or a 1.

Refer to the previous figure. The choice of MFA(x,0) vs. MFA(x,1), 'encoder input to TMP' (or "source
counts") versus 'motor output from TMP' (or "intermediate counts") is application-dependent. You
should use whichever represents the values used in your application. In other words, it should be values
that you want to keep the same effect even if MEMUL/MFDIV is changed.

NOTE: The MFA(x,1) format of the command is based on the output of the TMP function
(intermediate counts); it IS NOT the motor/shaft total output!

For example:

« If you know that you need to follow a conveyor (not driven by the SmartMotor) and accelerate
over 1000 counts distance on that conveyor as the input value, then choose MFA(x,0) for source
counts.

» |If you know that you need Follow mode, and the output distance of the acceleration needs to be
a certain distance of the conveyor being driven by a SmartMotor, then choose MFA(x,1) for
intermediate counts.

When in Cam mode, the output of the TMP function goes into the cam. Therefore, you will likely want to
select MFA(x,1) to ensure the cam input is a known amount for the TMP (i.e., you will execute a known
portion of the cam regardless of the MFMUL/MFDIV settings). If you have a cam application and you
need values in terms of source counts distances, then some additional calculations will be needed in the
program (based on the examples given). Refer to the figure Source Counts into Cam versus
Intermediate Counts into Cam on page 161.

Should | choose Variable or Fixed cam?

The choice of fixed length segments vs. variable length segments in a cam is another choice to make.

Generally speaking, fixed-length segments are simpler and allow more overall points because less
storage space is needed. This works well if you have a large amount of uniformly sampled data points,
for example, the output of a CAD drawing.

Variable segment lengths allow for some special applications. You can more carefully craft a set of
data points that exactly coincide with certain events in the cam input. If you have a set of data points
where you want to reach a specific position for a specific distance of the input (but that doesn't line up
with a regularly-sampled rate), then the variable-length segments can be used to exactly line up with
those input values. This can produce a smoother, and more predictable, result if spline interpolation is
enabled in Cam mode.

Further, with variable segments, there is a possibility that certain types of applications could
significantly reduce the number of cam points required. For example, there is a tool in SMI that can
take data points and apply a "data pruning” to reduce the number of cam points required. However, the
tradeoff is that each remaining point requires more storage space but the overall table possibly uses
vastly fewer points. In addition, variable-segment cams make it easier to have specific linear and spline
interpolated moves in a reduced cam table, allowing sharp corners mixed with smooth curves in a single
path.
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Source Counts into Cam - MFA, MFD, MFSLEW use command (x,0)

Ratio / MFA(x,0), MFD(x,0), MFSLEW(x,0)
7 MFMUL
Ratio = DIV
>
> > > Input o
1000 5000 1200 counts E
=
ry o
Slope is the ratio MFMUL/MFDIV 1200 3 o
regardless of input or output 2 7 If MEMUL or MFDIV are . a
distance A changed, the new move will -
TMP 3 respect the output targets and -
output 5000 * 7 adjust output accordingly. S
o
X 1000 N 3 MFA(1000,0) MFMUL=3
< - - - - = - T 2 7 > MFSLEW(5000,0) MFDIV=7
Input MFD(1200,0)
counts
0 1000 6000 7200

Intermediate Counts into Cam Diagram - MFA, MFD, MFSLEW use command (x,1)
When MFA(x,1), MFD(x,1), MFSLEW(x,1),

Ratio /4 the firmware back-figures which input
MFMUL values are needed to achieve this:
Ratio = ———— 7
MEDIV 72a=—%*2%1000
' 3
> 7
> > > Input ?b = — * 5000
7a b c counts 3
2c= - *2%1200
— 7200 3
Slope is the ratio MEMUL/MFDIV 1200 The ratio of MFMUL/MFDIV is still
regardless of input or output “ 6000 respected.
TMP distance If MFMUL or MFDIV are changed, the
output 5000 new move will respect the output
target and adjust inputs accordingly.
7y 1000
1000 MFA(1000,1) MFMUL=3
Input) MFSLEW(5000,1) MFDIV=7

counts MFD(1200,1)

Source Counts into Cam versus Intermediate Counts into Cam
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Part 1: Programming: Electronic Camming Notes and Best Practices

Electronic Camming Notes and Best Practices

These are important notes and best practices for electronic camming applications:

« The first cam point should be CTW(0,0) or CTW(0) variable length or fixed length cam segment,
respectively.

o Itis up to the programmer to pick a repeating cycle of the TMP function (MFA + MFSLEW +
MFD) that also matches the controller length of the table (CTA). Note that:

e The output of MFA, MFSLEW and MFD are physically executed in sequence. They DO NOT
overlap in any way (see the next bullets). Therefore, it may be helpful to place them in
sequence in your program.

« For simplicity, use MFA(x,1), MFSLEW(y,1), and MFD(z,1), output from TMP counts,
because then: x+y+z = the total distance as input into the cam.
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For example, if your cam repeats every 800 input counts, then you must distribute that
800 counts over the ascend, slew, and descend parts of the TMP. For an illustration of the
parts of the TMP, refer to the Gearing Profile figure on page 144.

NOTE: DO NOT assume that MFSLEW (slew) alone is the total cam length; it is not!

« |f the application needs to function in terms of input encoder counts (see the previous
figure), then these transforms must be considered:

TMP ascend and descend relationship is: Output = (Input/2) * (MFMUL/MFDIV)
Slew section is: Output = Input * (MFMUL/MFDIV)

« As shown in the previous two bullets, MEFMUL and MFDIV are imposed on command(x,0)
values. However, note that MEMUL and MFDIV still have an effect in both modes (i.e., the
ratio of input to output counts is still MEMUL/MFDIV). The difference is the final output
value used as the trigger to go to the next phase is not affected in (x,1) mode.

o MFSDC takes two arguments. To disable any "repeating" of the TMP function, the command is
MFSDC(-1,0).

NOTE: MFSDC(-1) is seen as an error and won't change the existing setting.

For diagrams of MFSDC settings and their results, see MFSDC Modes on page 148. However,
note that the last mode shown is not for use with Cam mode.

o If no MFSLEW is set (default operation), the ramp function will execute MFA and then run
forever (until X command). Use the command MFSLEW(-1), MFSLEW(-1,0) or MFSLEW(-1,1) to
disable the slew distance (i.e., any of those three forms of MFSLEW will disable the slew
distance).

o Camming with gearing fed into it is the default operation, i.e., camming with gearing of
MFMUL=1, MFDIV=1, the MFA and MFD commands are at O distance, and MFSLEW is ignored. In
this default operation, if you issue MC, G commands, the motor starts camming off of the source
SRC(1, or 2) immediately. When a set single shot or repeated cycle is desired, that is where
MFSDC and the other commands come into play, especially for label feeding, traverse cutting,
and similar applications. For an example, refer to the sample program Camming - Demo XY Circle
on page 875.
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» Always structure the program to minimize writing of the cam table to the EEPROM.

CAUTION: When writing a cam table to EEPROM, structure the program so
that the cam table is not frequently rewritten or written from a loop.

Repeated erasing and rewriting can burn bits and corrupt data.

There are various ways to achieve this—refer to the next code snippet for one example:

C1l23 'Example of using EEPROM to flag code that has been run &
EPTR=100 'set pointer to EEPROM =
VLD (a,1) 'load value =
IF al!=123 'if value does not equal 123 ?.
o
'do something here that you want to do only once C&
'such as write a cam table to nonvolatile memory :j
©
EPTR=100 'set EEPROM pointer o
a=123 !
VST (a, 1) 'write value to EEPROM
ELSE
'something was already done
ENDIF
RETURN
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Part 1: Programming: Examples

Examples

Fixed cam example with both controller or follower counts as inputs to the cam:

CTE (1)
CTA (5,8000)
CTW (0) 'CP=0 {cam pointer or cam index pointer}
CTW (500) 'CP=1
CTW (4000) 'CP=2
CTW (500) 'Will turn off at this point
CTW (0)
MFMUL=1
MEDIV=2
MCMUL=3
MCDIV=4

'Cam input values in terms of "controller" (encoder input to ramp) counts:
MFA (a, 0)

MFSLEW (s, 0)

MFD (d, 0)

'(a/2 + s + d/2) * MFMUL/MFDIV = 8000*4 = 32000 counts

'OR, cam input values in terms of "follower" (motor output from ramp)counts:
MFA (a, 1)

MFSLEW (s, 1)

MFD(d, 1)

'ats+d = 8000*4 = 32000 counts

Variable cam example with both controller or follower counts as inputs to the cam:

CTE (1)
CTA(5,0)
CTW (0, 0) 'CP=0 {cam pointer or cam index pointer}
CTW (500, 8000) 'Cp=1
CTW (4000, 16000) 'Cp=2
CTW (500, 24000) 'Will turn off at this point
CTW(0,32000)
MFMUL=1
MFDIV=2
MCMUL=3
MCDIV=4

'Cam input values in terms of "controller" (encoder input to ramp) counts:
MFA (a, 0)

MFSLEW (s, 0)

MED (d, 0)

'(a/2 + s + d/2 ) * MFMUL/MFDIV = 32000

'OR, cam input values in terms of "follower" (motor output from ramp) counts:
MFA (a,1)

MESLEW (s, 1)

MFD(d, 1)

'ats+d = 32000

Electronic Gearing and Camming over CANopen

Beginning with firmware 5.x.4.30 and later, the SmartMotor provides precise time synchronization over
CANopen between motors for electronic gearing and camming applications (for example, traverse and
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Part 1: Programming: Electronic Camming Commands

take-up spooling). The CANopen objects related to this are: 1005h, 1006h, 2207h, 2208h, 2209h,
220Ah-220Dh. For details on these objects refer to the SmartMotor CANopen Guide. For a sample user
program, see CAN Bus - Time Sync Follow Encoder on page 883.

NOTE: This capability is currently available on Class 5 SmartMotors only.
Electronic Camming Commands

The next sections describe related commands. For more details on these commands, see Part 2:
SmartMotor Command Reference on page 247.

CTE(table)

Erase tables in EEPROM memory starting at the value specified

To erase all EEPROM tables, choose CTE(1). By choosing a number higher than 1, lower table numbers
can be preserved. If, for example, there were three tables stored, CTE(2) would erase table 2 and 3, but
not table 1. CTE(0) is not defined.

CTA(points,seglen[,location])

Add a Cam table

The CTA command configures a table to use either EEPROM memory (default) or the data variable
space (optional) in preparation for writing the table with the CTW command.

points Specifies the number of points in the table.

seglen Specifies the controller encoder distance between each point. If seglen is set
to O, then the distance is specified per data record through the CTW command.

[location] s optional and specifies if this is a table in user variables or EEPROM. By
default, if [location] is omitted, then EEPROM is chosen. If [,location] is O, then
the user array location is chosen (al[0] through al[50].) Only one table can exist
in the user variables. Up to 10 tables (numbered 1 through 10) can exist in
EEPROM location.

CTW(pos[,seglen][,user])

Write a Cam table

The CTW command writes to the table addressed by the most recent CTA command. CTW writes to
either the EEPROM-stored tables or the user-array-stored tables.

NOTE: Typically, the actual Cam table would not be part of the program that executes the mode.
SMI tools are available to facilitate Cam table generation.

pos The position coordinate of the motor for that data point. The first point in the
table should be set to 0 to avoid confusion. When the table is run, the currently
commanded motor position seamlessly becomes the starting point of the table.
By keeping the first point of the table at O, it is easier to realize that all of the
data points are relative to that starting point.

[seglen] If this Cam table was specified as variable length in the CTA command, then
[seglen] is required for each data point. It is optional when using a fixed-length
Cam table (specified in the CTA command). [,seglen] represents the absolute
distance of the encoder source beginning from the start of the table. For
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Part 1: Programming: MCE(arg)

reasons similar to pos, [,seglen] should also be O for the first data point
specified.

If you wish to use the optional [,user] parameter, then the [,seglen] parameter
must be used (set to the default: 0).

[user] Optional. Defines Cam user bits and Spline mode override. It is an 8-bit binary
weighted value where:

Bit 0-5: User may apply as desired to Cam status bits 0-5 of Status word 8.
Bit 6: Factory Reserved — leave as 0.

Bit 7: When set to 0, no special override of Spline mode. When set to 1, the
segment between the previous point and this point are forced into linear
interpolation. Bit 7 has no effect when MCE has chosen linear mode.

When loading Cam tables, it is important to be aware of the table capacity. As mentioned previously:

« When a Cam table is stored in user array memory (al[0]-al[50]), 52 points can be stored as fixed-
length segments; 35 points are possible when variable-length segments are used.

» When Cam tables are written to EEPROM memory, significantly more data can be written. For
fixed-length segments, there is space for at least 750 points. For variable-length segments, at
least 500 points can be written.

MCE(arg)

Cam table interpolation mode

The MCE(arg) command sets up the Cam function and defines the behavior based on these arguments:

0 Force linear motion for all sections

1 Spline mode with non-periodic data at ends of table

2 Spline mode with periodic data wrapped at ends of table
MCW(table,point)

Cam table starting point

The MCW() command determines where to start the Cam function.

table Defines the Cam table number

point Defines the starting point in the table

RCP

Read Cam pointer

The RCP command reports the Cam pointer, and the CP variable can be used by the user program.
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RCTT

Read number of Cam tables

The RCTT command reports the number of Cam tables, and the CTT variable can be used by the user
program.

mcC

Enter Cam mode

The MC command enters Cam mode and must be issued before the G command.

MCMUL=formula

Cam table value multiplier

This value is multiplied by the Cam table value and fed as a commanded value to the trajectory of the
camming motor.

MCDIV=formula

Cam table value divisor

This value is divided into the Cam table value and fed as a commanded value to the trajectory of the
camming motor

O(arg)=formula

Set move generator origin to value

The O()= command sets the move generator origin based on these arguments:

0 Set the origin of the global move generator (sets value of PA)
1 Set the origin of move generator 1 (sets value of PC(1))
2 Set the origin of move generator 2 (sets value of PC(2))

OSH(arg)=formula

Shift move generator origin to value

The OSH()= command shifts the move generator origin based on these arguments:

0 Shift the origin of the global move generator (sets value of PA)
1 Shift the origin of move generator 1 (sets value of PC(1))
2 Shift the origin of move generator 2 (sets value of PC(2))
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Part 1: Programming: Cam Example Program

Cam Example Program
The next chart shows a plot of from the example code below it. This shows the effects of certain status

bits, I/0 points and the resulting motion profile. For add